
About Managing Files and Directories
Working with files and directories

It is easy to manipulate files and directories with the Norton Commander. You can copy, move, compress, compare and delete files 
and directories, and make two directories identical. You can also view and edit files, and view compressed and image files as if they 
were directories. You should be familiar with the basic directory and file display techniques.

Click here {button ,AL("copy;files;folders;link;disks;networks;compress")} for related information.



About Copying Files and Directories
You can copy files and directories to another location on your hard disk, on a network, to a floppy disk, to a compressed file, to an 
image file or, using the Commander Link facility, even to another computer.

Click here {button ,AL("copy;files;folders;link;disks;networks;compress")} for related information.



About Moving or Renaming Files and Directories
You can move files and directories to another location on your hard disk, on a network, to a floppy disk, to a compressed file, to an 
image file or, using the Commander Link facility, to another computer.

Tip: You can use the Rename command to turn a .ZIP file into a self-extracting .EXE file.

Click here {button ,AL("move;files;folders;link;disks;networks;compress")} for related information.



About Comparing Files and Directories
You often need to compare the files in a directory before copying or deleting files. You can use the Compare Directories facility to 
determine which files you want to keep.

Sometimes two files, often updated copies, are very close in size but not exactly the same. You can use the Compare Files facility to
see what those differences are.

Click here {button ,AL("move;files;folders;link;disks;networks;compress")} for related information.



About Viewing Files
The Norton Commander displays the contents of most leading database, spreadsheet, word processor and graphics files without 
running the applications that created them. 

You can view files in two ways: either with View from the Files menu or with Quick View from the Left or Right menus. The Quick 
View command displays files in the inactive panel. The View command pops up a window on top of the Norton Commander to 
display the file.

Caution: You should install Quick View on Windows (or Quick View Plus) to get the most from the View command.

When you choose to view a file, either with View from the Files menu or with Quick View from the Left or Right menus, the Norton 
Commander checks to see if you have Windows Quick View or Inso's Quick View Plus installed. If you don’t, the internal NC Viewer 
is used. The internal viewer’s only command is Exit.

Quick View comes with Windows, although it is not installed as default. Quick View Plus is a product of Inso Corporation.

Click here {button ,AL("view;quickview;files;qvplus")} for related information.



About Sorting Files
If you are displaying the directory panels in a Brief or Full format, you can choose the order in which files are displayed. The files 
can be sorted by: Name, Type, Date or Size, or left unsorted. The default is to sort by name. You can sort the files using either the 
menus or the shortcut keys.

Click here {button ,AL("files;sort")} for related information.



About Editing Files
You can edit text files in the Norton Commander. If you didn't specify use of an external editor in the General tab of the Configuration
Options from the Commands menu, the Norton Commander editor is used.
To Do this
Edit a file from the file list Select the file, and press F4 or choose Edit from the Files menu or click on the 

Edit icon in the toolbar.
Specify the name of the file you want to edit Press Shift+F4. Enter the filename in the File name textbox, or locate the file and 

click on it.
Create a new file Press Shift+F4 and enter the new filename. 
Select Commander editor, even if an external Press ALT+F4.
editor has been specified in the 
Configuration Options dialog box

Click here {button ,AL("files;edit")} for related information.



About Finding Files
The Find File command locates files by searching through all the drives (including network drives) and directories on one or more 
disks (including CD-rom and optical disks). Find File also finds hidden and system files not displayed by the DOS DIR command. In 
addition, you can limit a search to files of particular types, with particular dates, times and attributes. You can also limit searches to 
files containing a particular text string.

When the files have been located you can send the found files to a Results panel, where you can work with them just as you work in
other panels. For example, you might want to find all temporary files so that you can delete them.

You can use the Find File command to perform a simple file search using standard DOS wildcard characters * and ?. You can also 
perform an advanced search using more complex patterns. These complex patterns are called regular expressions — where you 
use special characters to extend the power of the search.

Use Find File when you need to use a file, or group of files, but don’t know where they are located. You can also find a file when you
know some of the text it contains but can’t remember its filename. 

When the search for files is finished, you can choose to:
 Define a new search
 View the highlighted file
 Go to the highlighted file
 Send the list of files to a Results panel

Note: Files sent to a Results panel can be worked on in the same way as files in all other panel formats.

You can also use speed search to find files quickly.

Click here {button ,AL("files;find")} for related information.



About Using Advanced Search Criteria to Find Files
The Norton Commander provides a set of special symbols — regular expressions — that can be used on their own, or combined 
with each other, to create a more advanced search pattern.

These symbols can be used when specifying the name of the file to search for, and when specifying the text to find. When searching
for text, some additional symbols are available to take account of tabs and new lines.

Regular expressions are particularly useful for: 

Extending the search to take account of many possibilities — similar to the DOS wildcards * and ?.

Excluding files from a search — such as all files starting with ‘a’ or ‘b’.

Narrowing the search to a particular range — such as all files containing words that start with any letter between ‘w’ and ‘z’.

Note: When searching for text, the strings specified in a regular expression are case sensitive.

Using regular expressions in Long File Names

You can use Long File Names when searching for files. You must put LFNs that include spaces within quotation marks.

Note: The wildcards * and ? are acceptable. However, the characters [ and ] are not, as these are valid characters in LFNs.

Click here {button ,AL("files;find;expressions")} for related information.



Symbols for Creating File Specifications

The following table shows the symbols available for creating a file specification.

Symbol Descriptions Examples Finds

? Match any single character. test?.doc test1.doc, test2.doc, testa.doc, 
testb.doc,

"testmains?.doc" testmains1.doc, testmains2.doc, 
testmainsa.doc, testmainsb.doc

* Match none or any instances of any 
character — similar to the DOS wildcard *

*.* All Files

*.bat All files with the extension .bat

a*.bat All .bat files beginning with `a'.

"a*.bat" All .bat files, including LFNs that 
include spaces, beginning with `a'.

[] Use a group of characters in a pattern. 
The characters are placed between the 
brackets. Do not place spaces between 
characters — spaces will be treated as a 
character in the search pattern.

[a-c]*.bat Locates files which have the .bat 
extension and start with either `a','b', or 
`c'.

[x] Match any one of the characters between
brackets

[abc]*.* Any files beginning with `a','b' or `c'.

[x-x] Match any one of the characters in the 
range listed within brackets.

[a-e]*.* All files beginning with `a', `b', `c', `d' 
and `e'.

[d-h]*.bat All files with the extension .bat 
beginning with `d', `e', `f', `g' and `h'.

~ Match everything specified but exclude 
files following ~

*.bat 
~autoexec.bat

Locates all files with the extension .bat 
except the autoexec.bat

*.bat ~a*.bat Locates all files with the extension .bat 
except those beginning with `a'.

*.com ~\dos\*.* Locates all files with the extension .com
except the files in the DOS directory.

*.bat ~[a-
c]*.bat

Locates all files with the extension .bat 
except those which have the .bat 
extension and start with either `a','b', or 
`c'.

[^x] Match everything specified except any 
one of the characters contained in 
brackets

[^adt]*.* Locates files which do not begin with 
the letters a, d or t.

Click here {button ,AL("filters;expressions")} for related information.



Symbols for Creating Text Specifications

The following table shows the symbols available for creating a text specification.

Symbol Descriptions Examples Finds

? Contains any single character. t?p Locates files containing three-letter words 
with a t and a p separated by another 
character such as tip, tap and top.

* Contains zero or more occurrences of the 
preceding character.

SET *TEMP Matches files containing the words SET 
TEMP separated by zero or more spaces. It 
will find SETTEMP and SET TEMP.

t?p?* Locates files containing any words starting 
with t, followed by any character, followed by
p, followed by any number of characters. 
This search will find words such as tip, top, 
tepee, tepid.

[ ] Use a group of characters in a pattern. 
Contains any one of characters specified in
the group. To use the `[` and `]' in the 
search pattern, you must place the closing 
bracket first. See the examples below for 
more details.

T[ioIO]P Locates files containing the following strings:
TIP, TOP, TiP, ToP.

M[a-p A-P]P Locates files containing the strings: MaP, 
MAP, MbP, MBP, McP, MCP, etc

[]] Locates files containing the character `]'

[[] Locates files containing the character `[`

[][] Locates files containing either `[` or `]'. Note 
the closing bracket must be used first.

^ This symbol has two purposes. When 

placed inside a group, it tells Norton 

Commander to locate all files which do not 

contain any of the characters in the group. 

When used outside a group, it tells Norton 

Commander to start matching at the start 

of a line. 

[^a-zA-Z] Locates files which do not contain any 
characters between `a' and `z' — either 
uppercase or lowercase.

^int Locates files which have the word `int' at the 
start of a line.

Click here {button ,AL("filters;expressions")} for related information.



Symbols for Finding Special Characters

The following table summarizes the use of these symbols.

Symbol Descriptions Examples Finds
$ Indicates the end of a line. Not to be 

confused with a carriage return or a new 
line.

sample$ Locates files that have the word sample at 
the end of a line.

^ Tells the Norton Commander to start 
matching at the start of a line.

^int Locates files that have int at the start of a 
line.

^int?*(?*)?*$ Locates files that have int at the start of a 
line, followed by any number of characters 
preceding a set of brackets that contain any 
amount of text. Programmers will recognise 
this as a useful way to search files containing
a function that returns an integer! Those who 
understood this and are not programmers 
should consider a job in the software 
industry!

\n Contains the word specified after \n at the 
beginning of a line.

\ntest Locates files that have the .word test in the 
beginning of a line.

:\n Matches files where a colon is followed by a 
new line.

;\ntest Matches files where a semicolon is followed 
by a new line beginning with the word test.

Click here {button ,AL("find;filters;expressions")} for related information.



About Splitting or Merging Files
You often find that files are too big to copy onto a floppy disk — for example, postscript files tend to be very large files. With the 
Norton Commander Split and Merge function you can split the file into a number of segments, copy these segments onto a floppy 
disk and merge them at a later stage.

Click here {button ,AL("files;split")} for related information.



About Deleting Files and Directories
You can delete directories and files from the selected drive. If you check the Delete to recycle bin checkbox, you can recover your 
deleted directories and files later if you made a mistake.

Click here {button ,AL("delete;files;folders;link;disks;networks;compress")} for related information.



About Compressing Files and Directories
Compressed files save disk space. A compressed file takes up much less disk space than files that are not compressed. When you 
want to access the files again, you just decompress them.

The Norton Commander makes handling compressed files easy, by treating a compressed file as a directory. You can view the 
contents of a compressed file by double clicking on the file with the mouse.

If you select a file from the contents of the compressed file and copy it, or move it to another location, it is automatically 
decompressed before it is moved or copied.

Caution: The PAK and ARC compression types do not support long filenames.

Click here {button ,AL("compress;files")} for related information.



About Manipulating Panels
Managing panels

The Norton Commander provides two directory panels. You can decide how you want to display the panels, what files to include in 
the file list and the order in which the files appear. These options are available from the Left and Right menus.

You can work in One Panel mode, or split a panel between itself and an editor. These options are available from the View menu and 
the Toolbar. You can also re-size a panel by dragging the center bar right or left.

Displaying the panels

The Norton Commander panels can be displayed in four formats: Brief (the default), Full, Tree and Results.

Format Result

Brief Displays a list of directories and files on the selected drive. If you select a 
directory, the subdirectories and files in that directory are listed. File information 
about each highlighted file is displayed in the mini-status line at the bottom of the 
panel.

Full Like the Brief format, it displays a list of directories and files on the selected drive. 
Additionally, the size, date, time and attributes of each file are shown in adjacent 
columns.

Tree Displays a directory tree for the current drive. If, for example, you select the Tree 
format from the Left menu, a directory tree for the right panel is displayed. As you 
scroll through the directory tree in the left panel, the files contained in each 
directory are displayed in the right panel. You can expand or collapse directories 
by double-clicking on them. The directory highlighted in the tree panel becomes 
the current directory.

Results Displays a list of files found when you use the Find File command from the 
Commands menu. You must select the Send to Panel button on the Find File 
dialog box to create the list of files found. This list of files is saved until the next 
time you run Find File. You can handle files in the Results panel in the same way 
as in other panel formats.

 

The panel formats for each directory panel work independently. You can display the left panel in Brief format, while displaying the 
right panel in Full format.

Note: Press CTRL+U or choose Swap Panels from the Commands menu to swap the panels around. 

Adjusting panel sizes

The Norton Commander panels can be enlarged or split to suit your needs. The options on the View menu are Two Panels or Split 
Panels. You can re-size panels using the mouse

Display Result

One Panel Displays the active panel over the whole screen. This is useful when you are viewing a large directory 
and want to see as much as possible. If you toggle Two Panels on the View menu (or click the icon on 
the Toolbar), the active panel fills the screen, and the other panel disappears. Toggling Two Panels again 
restores your original display.

Split Panels Displays a selected file with a viewer or editor over the bottom-half of the active panel. Select a file and 
then select Split panels from the View menu (or click the icon on the Toolbar). The file is displayed below 
the directory.

Re-size Panels Displays two panels in any proportion. You can get a bigger view of one panel but still retain a glimpse of 
the other. Move the mouse pointer to center bar in the middle of the screen. When you see the cross-hair,
you can drag the center bar right or left. Double-clicking on the center bar will restore the panels to the 
default positions.

The default display is Two Panels.



Click here {button ,AL("view;panels")} for related information.



About Mapping Drives
Once you have attached to a server, you can associate drives with the volumes and directories on that server, to make navigation 
easier. This is known as "mapping" a drive. (Consult your DOS manual if you want to find out more about the DOS MAP command). 

If you regularly use a volume or directory on a server and want to save time accessing that area, you can map a drive on your 
computer to that area.

There are two ways to map a drive to a server. If you are already attached to the server/volume/directory that you want to map a 
drive to, you can choose Map Network Drive from the Disk menu to quickly map the drive. If you want to map a drive to an area that 
you are not attached to, choose Network Utilities from the Disk menu.

Click here {button ,AL("networks")} for related information.



About Attaching to a Network Server
The Norton Commander simplifies working on a network. Using the Norton Commander Network Utilities you can view server 
details, attach to and detach from servers and map to drives — all through a familiar interface.

When you want to access a network server, you first need to establish a link to that server. This is known as "attaching" to a server. 
Once you have attached to a server, you can associate drives with the volumes and directories on that server, to make navigation 
easier. This is known as "mapping" a drive. (Consult your DOS manual if you want to find out more about the DOS MAP command). 

Click here {button ,AL("networks")} for related information.



About Configuring Norton Commander
You can configure the Norton Commander to suit your personal tastes and preferences. You can change what is shown on the 
screen, the contents of the panels, compression options, as well as choosing the type of editor to be used in the Norton 
Commander. Most of the configuration is set using the Configuration option from the Commands menu.

The Configuration Options dialog has four tabs: General, Screen, Colors and Compatibility. Each tab has a number of configuration 
options. Here is a brief overview of the tabs, what they feature and what your choices are.
TabFeatures
General Confirmation, editor, compression and auto-save options.
Screen User interface, panel and screen saver options.
Colors Color and font options.
Compatibility Windows/NC mode options.

Click here {button ,AL("configure")} for related information.



About Configuring Windows/NC Mode
The compatibility tab is concerned with the Norton Commander's mode of operation. In the Compatibility tab, you can set the Norton
Commander's mouse, speed search and delete functions to work as they did in previous versions of the Norton Commander, or as 
they do in Windows.

The Norton Commander's speed search uses the keyboard to quickly select a file in a panel. By default, pressing CTRL+ALT 
initiates the speed search. You can switch to pressing ALT only, or switch to simply pressing the first letter of the file or directory that 
you want to find.

By default the Norton Commander uses a right-handed mouse: the left button points and the right button selects. You can switch to 
a Windows-style mouse, so that the button actions work differently: the left button selects and the right button pops up a menu with 
useful items from the Files and Commands menus.

You can choose to send deleted items to the Windows Recycle Bin, thus protecting them in case you change your mind later.

Click here {button ,AL("configure;find")} for related information.



About Using Filters
File filters

The Norton Commander file filters let you specify the files you want to display or manipulate. You can use the filters that are included
with the Norton Commander, or create custom filters.

Panel filters and operations filters

There are two types of filters in the Norton Commander — panel filters and operations filters. Panel filters are used to specify what is
displayed on a panel, operations filters are used to specify the files on which you want to perform an action — such as copy, move, 
delete or compress.

Click here {button ,AL("filters")} for related information.



About Using Panel Filters
Using panel filters

Panel filters are used to specify what files are displayed in the active panel. You can access panel filters (or create custom filters) by 
choosing Filter from the Left or Right menus. You can use a different panel filter on each panel.

Clearing filters

If you have been using either panel or operations filters and want to return to an unfiltered view, you can clear the filter by clicking on
the Clear button in the Filter Setup dialog box.

Click here {button ,AL("filters")} for related information.



About Using Operations Filters
Using operations filters

Operations filters are used when performing actions such as:
 Copying files
 Moving or renaming files
 Deleting files
 Compressing and decompressing files
 Setting file attributes

These filters are accessed by clicking on the Filters button when performing one of the operations listed above. They work 
independently of panel filters specified from the Left or Right menus.

Clearing filters

If you have been using either panel or operations filters and want to return to an unfiltered view, you can clear the filter by clicking on
the Clear button in the Filter Setup dialog box.

Click here {button ,AL("filters;operations")} for related information.



About Using File Filters
The Norton Commander has a number of pre-defined file filters for use in commonly performed searches. These are Executable, 
Database, Spreadsheet, Word Processor, Graphics and Compressed file filters. Each filter has a default filter specification which 
you can use as is, or modify to suit your own preferences. You can also create your own custom file filters.

Click here {button ,AL("filters;files")} for related information.



About Specifying File Filters
When using the Filter Setup dialog, you can a use combination of categories to create a filter specification:
For Go To
File Name(s) Go to the Name & Attributes tab
File Attribute(s) Go to the Name & Attributes tab
File Size Go to the Date & Size tab
File Date Go to the Date & Size tab
Text contained in the file Go to the Containing tab

File Attribute(s)

If you check multiple attribute boxes, files will not be considered a match unless each of the checked attributes is set.

Hidden — Check to find files that do not appear in normal directory listings.

System — Check to find files with the system attribute set. System attributes indicate a DOS or system-related file.

Read only — Check to find files that are read-only. The read-only attribute protects a file from being modified or deleted.

Archive — Check to find all files that have not been backed up.

Directory — Check to find only directories and sub-directories.

None — Check to find files with no attribute set.

File Date

Use the Date category to filter files based on the dates and times they were last modified.

The Date & Size tab

Type the dates and times in the Between textboxes, with the Date first, followed by a space, and (optionally) the time. For example: 

Between: 10/10/95 9:00 and 09/01/96 19:00

Tip: You can specify files modified before or after a particular date by leaving one or the other of the Between textboxes empty. For 
example, "Between 10/10/95 9.00 and [EMPTY TEXTBOX]" would include all files modified after 10 October 1995.

You can also customize your filter to include files modified during the previous x hours, days, weeks, and so on. Click the During 
Previous button to choose this option.

File Size

Use the Size category to filter files based on their size (in bytes). If you want to specify merely above or below a certain size, leave 
one or the other textbox empty. For example, "Between 5000 and [EMPTY TEXTBOX]" would include all files larger than 5000 bytes
(5K).

Contained text

Use the Textcategory to filter text files based on their contents. If you want to specify merely what text string you are looking for, 
simply enter the text in the Text drop-down listbox.

The Containing tab

If you want to specify case in a text string, check the Case sensitive checkbox.

If you want to use a regular expression to find variations on a text string, check the Regular expression checkbox.

If you want to limit your filter to text files only, check the Text files only checkbox.

Click here {button ,AL("filters")} for related information.



About Browsing Image Files
The Norton Commander handles image files much in the same way as compressed files, i.e., it treats an image file as a directory. 
You can view the contents of an image file by double clicking on the file with the mouse.

Click here {button ,AL("image;view")} for related information.



About Browsing Compressed Files
The Norton Commander makes handling compressed files easy, by treating a compressed file as a directory. You can view the 
contents of a compressed file by double clicking on the file with the mouse. 

Note: You cannot view individual files compressed with the ARC, ARJ OR PAK compression types. To view the contents of an ARC, 
ARJ OR PAK file, you must first decompress it.

Click here {button ,AL("compress")} for related information.



About Creating a User Menu
The Commander enables you to create user menus that contain a list of commonly used programs and commands. The user menu 
is stored in the Norton Commander directory; it can be accessed from any directory.

You can specify a hotkey to execute these programs or commands. The hot key can be any text key or CTRL plus any key, for 
example, W or CTRL+W.

Click here {button ,AL("configure")} for related information.



About Converting Local User Menus from Norton Commander 5.0
Norton Commander no longer supports Local User Menus. Now, only a single main User Menu is used. Information for this is stored
in the Windows 95 Registry.

If you have a Local User Menu (*.MNU) file from Norton Commander 5.0, you can convert it for use with Norton Commander for 
Windows. The Local User Menu Conversion Utility will convert the specified User Menu to the new format and add it to your current 
User Menu with Norton Commander for Windows.

Simply run the program called MNUTO95.EXE. Browse for the .MNU file you want to convert. The menu will be added to your 
Norton Commander for Windows 95 User Menu.

Note: If you enter duplicate User Menu names, their contents will appear in both/all menus of that name.

Click here {button ,AL("configure")} for related information.



About Cleaning Up Disks
Disk space often gets used up with unwanted and unnecessary files — many of which are created due to:
 product installations that create many versions of the AUTOEXEC.BAT, CONFIG.SYS, WIN.INI and SYSTEM.INI files, and place 

readme files on your hard disk.
 software applications that create temporary files on your hard disk.
 automatic backup — many products provide an automatic save facility that creates a backup of the file you are working on. Often 

this file is stored on the hard disk, even after the original file has been saved.

The Norton Commander provides a cleanup utility that automatically deletes unwanted files from your hard disk.

Caution: The Cleanup utility is very useful for controlling your hard disk space — however, use it with caution as you might delete 
important files in error.

Click here {button ,AL("disks;cleanup")} for related information.



About Using Commander Link
You can copy and move large groups of files between two computers with Commander Link. The two computers must be connected 
using a Commander cable via the serial or parallel ports. This is useful for transferring files from your laptop to your desktop 
computer.

Tip: For faster transfer speeds, use parallel ports.

Click here {button ,AL("operations;link")} for related information.



About Creating Image Files
An Image file is an exact copy of a disk — sector for sector, byte for byte. The Norton Commander allows you to create an Image file
and store it on your hard disk. You can copy the Image file at a later stage and have an exact copy of a disk.

Click here {button ,AL("image")} for related information.



Welcome to the Norton Commander
Welcome to the Norton Commander for Windows. The Norton Commander integrates DOS and Windows into an environment that 
is easy enough for everyone to use, yet powerful enough for the advanced user. The Norton Commander combines file 
management, file viewing, application launching, disk housekeeping facilities and PC-to-PC file transfer in one simple and consistent
user interface, equally accessible from keyboard or mouse.

New features

The Norton Commander takes advantage of all the power of Windows, including:
True 32-bit design The Norton Commander for Windows has been completely redesigned. Its 32-bit architecture 

permits you to run it in the background while you perform other tasks.
Long File Names Both the Norton Commander and the new NC Scheduler support LFN.
Enhanced drag & drop Now you can drag & drop files and directories to and from other windows, including the Windows 

desktop.
Viewers and associations The Norton Commander supports all Windows viewers and associations.
Flexible command structure The Norton Commander now packs more mouse power and a toolbar, in addition to improved 

menus and the Norton command line.
Improved user interface Combines the Norton Commander look and feel with all the Windows features, including right-click 

context help, accessibility from the Start menu and multi-tasking.

Not only does the Norton Commander work faster and more efficiently than ever, it has many new, important features:
The NC Scheduler The Norton Commander comes with a Scheduler to launch programs that you use regularly and 

send messages and reminders.
File comparison The Compare Directories command is now accompanied by Compare Files. Differences between 

two files, text or hex, are highlighted with color.
Browse image files Image files can be viewed with the Norton Commander as if they were directories.
More flexible panels It's easier than ever to get the `look' you want. Panels can be enlarged to full-screen size, or 

proportionately adjusted. A panel can also be split between itself and a viewer.
More configuration power Colors and fonts are now fully configurable. New User Interface features such as the toolbar and 

pop-up menus can be switched on or off. Plus Windows/NC mode configuration, to choose whether
you want the Norton Commander to behave more like Windows or like the Norton Commander.

Screen savers New screen savers are included with the Norton Commander. 
Enhanced file split/merge Now the Merge command can, if given one part of a split file, find the rest in a directory and merge 

them.

Click here {button ,AL("start")} for related information.





Copying Files and Directories: Troubleshooting
Error Message:

Access denied.
Problem:

The target directory may be read-only, or may not support Long File Names. If it is read-only, you cannot write to it. If it does not 
support LFNs, try using a name of 8 characters or less.

Error message:
Sharing violation.
Problem:

The file is being used by an application or another user. Close the application, or wait for the other user to finish.

Error message:
The target does not support Long File Names.
Problem:

The target directory is a server or computer that can read file names of 8 characters or less, plus a 3-character extension. Choose a 
new name that fits this criteria.

Click here {button ,AL("trouble;copy")} for related information.



Moving Files and Directories: Troubleshooting
Error Message:
Access denied.
Problem:

The target directory may be read-only, or may not support Long File Names. If it is read-only, you cannot write to it. If it does not 
support LFNs, try using a name of 8 characters or less.

Error message:

Sharing violation.
Problem:

The file is being used by an application or another user. Close the application, or wait for the other user to finish.

Error message:

The target does not support Long File Names.
Problem:

The target directory is a server or computer that can read file names of 8 characters or less, plus a 3-character extension. Choose a 
new name that fits this criteria.

Error message:
You can’t delete or rename the current directory.
Problem:

You can’t do this in a Tree panel or the NCD Tree. Close the tree and rename from a normal panel.

Error message:
You can’t use [NAME] in a directory name.
Problem:

You are using a character that is not permitted to be used in a directory name. Choose another name and try again.

Click here {button ,AL("trouble;move")} for related information.



Viewing Files: Troubleshooting
Problem:

If you cannot view files properly, try installing Quick View on Windows. If you want more viewing options, think about obtaining Quick
View Plus from Inso Corporation.

Click here {button ,AL("trouble;view;quickview;qvplus")} for related information.



Editing Files: Troubleshooting
Error message:

Can’t create the file [NAME].
Problem:

The disk is full.

Error message:
Sharing violation.
Problem:

The file is being used by an application or another user.

Click here {button ,AL("trouble;edit")} for related information.



Finding Files: Troubleshooting
Error message:
Sharing violation.
Problem:

The file is being used by an application or another user.

Click here {button ,AL("trouble;find")} for related information.



Deleting Files and Directories: Troubleshooting
Error message:
Sharing violation.
Problem:

The file is being used by an application or another user. Close the application, or wait for the other user to finish.

Error message:
You can’t delete or rename the current directory.
Problem:

You can’t do this in a Tree panel or the NCD Tree. Close the tree and rename from a normal panel.

Error message:
Can’t delete [NAME] because it is not empty or you don’t have access rights.
Problem:

You can’t delete some directories in the NCD Tree if they contain files. You must delete the files first.

Click here {button ,AL("trouble;delete")} for related information.



Viewing Compressed Files: Troubleshooting
Error Message:
Bad ZIP file.
Problem:

The Norton Commander cannot interpret the compressed file correctly. The file may be damaged or corrupted.

Dialog:
Open With: Choose the program you want to use to load [filename]
Problem:

You must first expand files not compressed in ZIP format before you can view them.

Click here {button ,AL("trouble;compress")} for related information.



Comparing Directories: Troubleshooting
Error Message:
You need two file panels to perform this command.
Problem:

You have to have two file panels open. Make sure that both panels are listing files.

Click here {button ,AL("trouble;compare")} for related information.



Synchronizing Directories: Troubleshooting
Error Message:
You need two file panels to perform this command.
Problem:

You have to have two file panels open. Make sure that both panels are listing files.

 Error Message:
You cannot synchronize a directory with itself.
Problem:

You have the same directory in both panels. Change one of them and try again.

Click here {button ,AL("trouble;synchronize")} for related information.



Browsing Image Files: Troubleshooting
Error Message:
Commander cannot interpret the image file correctly.
Problem:

The file may be of an unrecognized format or the disk may be damaged. Check the source of the image file for problems.

Click here {button ,AL("trouble;image")} for related information.



Copying Disks: Troubleshooting
Error Message:
This drive may not be formatted.
Problem:

You have tried to copy to/from a disk that the Norton Commander cannot read. Check the disk to see if:
 it is formatted properly.
 it is formatted for another computer (i.e., Macintosh or Amiga)
 it is damaged.

Error Message:
The target disk has a different format from the source disk.
Problem:

You may be trying to copy a 1.4 MB disk to a 720KB disk. Or the target disk may be formatted for another computer.

Error Message:
Source and destination drive types must be identical.
Problem:

You may be trying to copy a 1.4 MB disk to a 720KB disk.

Error Message:
General copy disk error.
Problem:

Commander has tried to verify the disk copy and encountered an error. The target disk may be unreliable.

Error Message:
Data mismatch found between destination and source.
Problem:

Commander has tried to verify the disk copy and encountered an error. The target disk may be unreliable.

Error Message:
The source and destination must be different image files.
Problem:

You cannot copy an image file to itself.

Click here {button ,AL("trouble;disks")} for related information.



Formatting Disks: Troubleshooting
Error Message:
This drive may not be formatted.
Problem:

You have tried to copy to/from a disk that the Norton Commander cannot read. Check the disk to see if:
 it is formatted properly.
 it is formatted for another computer (i.e., Macintosh or Amiga)
 it is damaged.

Error Message:
An error occurred during the format operation.
Problem:

The Norton Commander cannot complete the format operation for this disk. Make sure that you are formatting the proper size, i.e., 
1.4 MB or 720 KB. Check to see if the disk is damaged. If not, try to perform a Full format of the disk. If this does not work, do not 
use this disk.

Click here {button ,AL("trouble;disks")} for related information.



Viewing The NCD Tree: Troubleshooting
Error message:
You can’t delete or rename the current directory.
Problem:

You can’t do this in a Tree panel or the NCD Tree. Close the tree and rename from a normal panel.

Click here {button ,AL("trouble;tree")} for related information.



Using Commander Link: Troubleshooting
Error message:
Link timed out.
Problem:

You have lost your Commander Link connection. Try to establish it again.

Click here {button ,AL("trouble;link")} for related information.



Creating Image Files: Troubleshooting
Error Message:
You cannot copy an image file to a floppy drive.
Problem:

Image files are too large to store on floppy disks. They can only be stored on hard disks or networks.

Error Message:
Drive X: does not have enough space left to create disk image files.
Problem:

Your disk is (nearly) full. Create some space by moving or deleting files.

Click here {button ,AL("trouble;image")} for related information.



Printing Files: Troubleshooting
Error Message:
Windows is unable to print the file [NAME]. Do you wish to copy it to [NAME].
Problem:

Windows does not have an association with this file and does not know how to print it. The Norton Commander can try to print the 
file by copying it to a printer port. If your printer supports RAW output, then this option could work.

Error Message:
[NAME] is a device. Windows does not allow you to open devices.
Problem:

You have attempted to copy to a device such as PRN: or LPT1:, which is not permitted.

Click here {button ,AL("trouble;associate;files")} for related information.



Associating Files: Troubleshooting
Error Message:
The specified program could not be found.
Problem:

You have attempted to run a file by double-clicking on it, and either the associated program could not be found, or there is no 
association with the extension. Check to see if the program has been moved or deleted, otherwise set up a new association.

Click here {button ,AL("trouble;associate")} for related information.



NC Network Utilities: Troubleshooting
Error Message:
Could not find xxx.exe. Please check your Windows Setup
Problem:

The NC Network Utilities has tried to run WinPopup, System Monitor or Net Watcher and cannot find one of the executables. Check 
to see if you have installed the application on Windows.

Click here {button ,AL("trouble;networks")} for related information.





Copying Files and Directories
You can copy files and directories to another location on your hard disk, on the network, to a floppy disk, to a compressed file, to an 
image file or, using the Commander Link facility, even to another computer.

To copy files and directories:

1 Select the directories or files.

2 Choose Copy from the Files menu or press F5 or click on the Copy icon in the Toolbar. 

Tip: Using drag & drop, you can copy selected files and directories by dragging them to the other panel, to the Windows 
Desktop, or to another Window. If you are copying to the same drive, hold down the CTRL key before you begin dragging.

3 The directory in the other panel is displayed in the Copy dialog box. To quickly choose a different destination, press F10 or click 
on the Directory icon for the directory tree. You can select a directory by highlighting it and pressing Enter. You can also type a 
different or new target directory path in the To: drop-down listbox.

4 If you are copying directories and also want to copy all the relevant subdirectories and files, check Include Subdirectories.

5 If you want to perform the operation on files across a complete drive, press SHIFT+F5. For example, you can copy all *.TXT files
existing on a hard disk, floppy disk, CD-ROM or network drive to one centralized directory. If you check the Include 
Subdirectories checkbox, the directory structures of any directories containing .TXT files will be copied as well.

6 Choose a filter from the Use Filters pull-down listbox if you want to use filters in the copy procedure. Or click on the Filters button
to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

7 Check the Copy Newer Files Only checkbox to ensure that you do not overwrite a later version of a file with an earlier one.

Tip: You can use the Copy Newer Files Only option as a means of speeding up your copy procedure. 

8 Select Check Target Space if you want the Norton Commander to warn you if there is not enough space on the target disk to 
store the selected files.

9 Press Enter or click on Copy.

Tip: If you are copying one file, you can give the file a new name by typing the new name after the pathname.

Click here {button ,AL("copy;files;folders;link;disks;networks;compress")} for related information.



Moving Files and Directories
You can move files and directories to another location on your hard disk, on the network, to diskette, to a compressed file, to an 
image file or, using the Commander Link facility, to another computer. 

To rename or move files and directories:

1 Select the directories or files.

2 Choose Rename or Move from the Files menu or click on the Move icon in the Toolbar or press F6.

Tip: Using drag & drop, you can move selected files and directories by dragging them to the other panel, to the Windows 
Desktop, or to another Window. If you are moving to a different drive, hold down the SHIFT key before you begin dragging.

3 The directory in the other panel is displayed in the Move dialog box. To quickly choose a different destination, press F10 or click 
on the Directory icon for the directory tree. You can select a directory by highlighting it and pressing Enter. You can also type a 
different or new target directory path in the To: drop-down listbox.

4 If you are moving directories and also want to move all the relevant subdirectories and files, check Include Subdirectories.

5 If you want to perform the operation on files across a complete drive, press SHIFT+F6. For example, you can move all *.TXT 
files existing on a hard disk, floppy disk, CD-ROM or network drive to one centralized directory. If you check the Include 
Subdirectories checkbox, the directory structures of any directories containing .TXT files will be copied as well.

6 Choose a filter from the Use Filters pull-down listbox if you want to use filters in the rename procedure. Or click on the Filters 
button to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

7 Check the Move Newer Files Only checkbox to ensure that you do not overwrite a later version of a file with an earlier one.

Tip: You can use the Move Newer Files Only option as a means of speeding up your move procedure.

8 Select Check Target Space if you want the Norton Commander to warn you if there is not enough space on the target disk to 
store the selected files.

9 Press Enter, or click on Rename/Move. 

Remember that when you rename a directory or file, you are really moving it to a different filename in the same directory. 

Click here {button ,AL("move;files;folders;link;disks;networks;compress")} for related information.



Viewing Files
To view a file:

1 Move the selection bar to the file you want to view.

2 Select View from the Files menu or press F3 or click on the View icon in the toolbar. The file is displayed in a separate Windows 
pane.

Viewing a document
 To open the file for Editing, choose Edit from the File menu. If the file is associated with an application, the application will be used 

to edit the document.
 Both the Quick View toolbar and the Quick View Status Bar can be toggled on or off, independently of your Norton Commander 

configuration scheme.
 To view a document’s layout, choose Page View from the View menu.

Click here {button ,AL("view;quickview;files;qvplus;edit;associate")} for related information.



Using Quick View
Quick View allows you to view the contents of a file without launching the application that created it. It is available from both the Left 
and Right menus. 

Caution: You must install Quick View (or Quick View Plus) on Windows to get the most from the View command. To install Quick 
View (or to check if it’s installed), click on Add/Remove Programs in the Windows Control Panel. Select the Windows Setup tab and 
open Accessories. Click on Quick View so there is a checkmark next to it. Click on OK twice.

To view a selected file, press CTRL+Q or select Quick View from the left of Right menu. The adjacent panel changes to the Quick 
View format and displays the contents of the file. Pressing CTRL+Q again restores the panel to its previous format.

A file is automatically displayed when it is highlighted by the selection bar. To view a directory’s files in succession, press the Up or 
Down arrow keys.

Quick View handles different files in different ways:
File type Action
Data file The file is displayed
Application file (.EXE, .COM) Press Enter or double-click on the selection to launch the program
Directory Directory information is displayed
Graphics file The file is displayed

When a text file is displayed, you can edit it by pressing F4 (Edit). This invokes the editor you chose to use with the Norton 
Commander.

Click here {button ,AL("view;quickview;edit")} for related information.



Installing Windows Quick View
To install Quick View (or to check if it’s installed):

1 Click on Add/Remove Programs in the Windows Control Panel.

2 Select the Windows Setup tab and open Accessories.

3 Click on Quick View so there is a checkmark next to it.

4 Click on OK twice.

Note: If you want to install Quick View and do not have Windows .CAB files on your hard disk, you will need the CD-ROM or floppy 
disks that were used to install Windows.

Click here {button ,AL("view;install;quick view")} for related information.



Sorting Files
If you are displaying the directory panels in a Brief or Full format, you can choose the order in which files are displayed. The files 
can be sorted by: Name, Type, Date or Size, or left unsorted. The default is to sort by name. You can sort the files using either the 
menus or the shortcut keys.

To sort the files using menus:

1 Choose the Left or Right menu, depending on which panel you want to sort.

2 Choose your sort criteria, using the selection bar or the hot key.

Criteria Result
Name Sorts alphabetically by the filename, in ascending order
Type Sorts alphabetically by the file extension, in ascending order
Date Sorts by the last modified date and time, the latest date appears at the top of list
Size Sorts by the size of the file, the largest file appears at the top of the list

3 If you choose to leave the files Unsorted, the file list is determined by DOS.

Tip: Selecting the same sorting option twice toggles the order. For example, select Size, and the largest file appears at the top. 
Select Size again, and the order is reversed.

To sort the files using shortcut keys:
To Press
Sort by name CTRL+F3
Sort by type CTRL+F4
Sort by date CTRL+F5
Sort by size CTRL+F6
Choose an unsorted list CTRL+F7

Click here {button ,AL("files;menu")} for related information.



Editing Files
You can edit text files in the Norton Commander. If you didn't specify use of an external editor in the General tab of the Configuration
Options from the Commands menu, the Norton Commander editor is used.

When using the Norton Commander Editor, the following functions are available:
To Do this
Save the modified file. Press CTRL+S.
Save the modified file under another name. Press ALT+F then A.
Save the file and quit the editor. Press F10 and press Enter at the ‘Save Changes?’ prompt.
Quit without saving the file. Press F10 and ALT+N at the ‘Save Changes?’ prompt.
Mark a block of text. Use the left mouse button to mark the block of text.
Copy marked text. Press CTRL+C.
Paste marked text to the Press CTRL+V.
current cursor position.
Delete the marked text. Press CTRL+X.
Search for text. Press F7. Enter the string you want to search for. Click on Find Next.
Search and replace text. Press F4. Enter the search string and the replace string. Click on Find Next. Click

on Replace to change the current found string, or click on Replace All to change
all occurrences.

Display line/word count. Press F6.
Goto line number. Press F8.
Go to the beginning of the current line. Press Home.
Go to the end of the current line. Press End.
Go to the top of the file. Press CTRL+Home.
Go to the end of the file. Press CTRL+End.
Undo your last command or action. Press CTRL+Z.
Display Online Help contents. Press F1.

Click here {button ,AL("edit;view")} for related information.



Selecting Files
You can work with one or more files using the Norton Commander. Just select the files you want to work with and perform the 
required task.

Note: Select one or more files using the Insert key, or by clicking on the files with the right mouse button.

To select a group of related files or directories:

1 Choose Select Group from the Files menu, or press the plus (+) key on the numeric keypad.

2 In the Select dialog box, type the file specification for the files you want to select. For example, to select all files with an .EXE 
extension, type *.EXE.

3 Press Enter. All files with the extension EXE are selected.

4 You can select more than one group of files by separating your file specifications with a semi colon (;) or space. For example, to 
select all EXE and TXT files, type:

*.EXE;*.TXT
in the select dialog box.

Note: *.* or * selects all the files in the panel as default. If you checked Select Directories in the Screen tab of the Configuration 
Options dialog box, directories and the files contained in the directories are selected.

If you want to change the group of files selected, you can deselect the group.

To deselect a group of related files or directories:

1 Choose Deselect Group from the Files menu, or press the minus (-) key on the numeric keypad.

2 In the Deselect dialog box, type the file specification for the files you want to deselect. For example, to deselect all files with 
an .EXE extension, type *.EXE. 

3 Press Enter. All the .EXE files are deselected. Using the previous example, this means that only the .TXT files remain selected.

4 To deselect both .EXE and .TXT files type:

*.EXE;*.TXT.
Note: You can also select or deselect a file or directory using the Insert key or clicking on files with the right mouse button.

Click here {button ,AL("select;operations;filters")} for related information.



Inverting Selected Files
You can choose to select all the files that are not currently selected, and deselect all the selected files.

To invert your selection:

1 Choose Invert Selection from the Files menu, or press the asterisk (*) key on the numeric keypad.

2 Your selection is now inverted; all previously selected files are deselected, all files not previously selected are selected. 

Click here {button ,AL("select;operations")} for related information.



Restoring Inverted Selections
After a copy operation, it is possible to reselect all the files just copied.

To select the files you copied:

1 Select the panel from where the files were copied.

2 Choose Restore Selection from the Files menu.

Click here {button ,AL("select;operations")} for related information.



Finding Files
Use Find File when you need to use a file, or group of files, but don’t know where they are located. You can also find a file when you
know some of the text it contains but can’t remember its filename. 

When the search for files is finished, you can choose to:
 Define a new search
 View the highlighted file
 Go to the highlighted file
 Send the list of files to a Results panel

Note: Files sent to a Results panel can be worked on in the same way as files in all other panel formats.

To find a file:

1 Choose Find File from the Commands menu, or press ALT+F7. The Find File dialog box is displayed.

2 In the Find textbox, type the filename or the file specification for the group of files you want to find. In addition to the usual DOS 
wildcard symbols * and ?, Norton Commander provides an additional set of symbols — regular expressions — for defining the 
search criteria. For more information on using regular expressions, click here {button ,AL("expressions")}.

3 In the Location(s) drop-down listbox, specify the locations to search — the default is to search the entire drive.

Tip: Click on the browse icon to display a Tree view of the current drive. Highlight a directory and press Enter or click on OK) to 
place the path for that directory into the Location(s) text box.

4 Check the Find duplicates checkbox to specify that only duplicate filenames are located. This is useful if you want to find all 
versions of a file — such as command.com.

5 Check the Text files only checkbox if you want the search to ignore binary files (typically, executables and .DLLs). The Norton 
Commander will ignore files that have a NULL character within the first 100 bytes of the file.

6 For a more advanced search, click on the Filters button. For more information on using filters, click here {button ,AL("filters")}.

7 Choose the Start button or press Enter to commence the search.

The following buttons are available while the search is in progress:
Button Result
Stop Stops the search.
Go to Goes to a file panel showing the current directory, with the selected file in a Results panel highlighted.
Send to panel Sends all found files to a Results panel. 

Click here {button ,AL("filters;find;expressions;files")} for related information.



Using Advanced Search Criteria
Use advanced search criteria to find files when you are looking for multiple files, variations on filenames, and text within files.

To find a file using advanced search criteria:

1 Choose Find File from the Commands menu, or press ALT+F7. The Find File dialog box is displayed.

2 Click on the Filters button. For more information on using filters, click here {button ,AL("filters")}.

3 Select the Containing tab. Type the text in the Text field.

4 If you check the Regular Expression checkbox, you can then use special symbols — regular expressions — to create a more 
advanced search pattern. For more information on using regular expressions, click here {button ,AL("expressions")}.

5 To limit the search to files with particular dates, times, attributes or sizes, click on the Filters button, and select the Names & 
Attributes or the Date & Size tab. 

6 Type in the appropriate dates and sizes, and check the appropriate attributes. 

When you have finished selecting your filter, click on OK or press Enter to return to the Find File dialog.

Click here {button ,AL("files;find;filters;expressions")} for related information.



Finding Files Using Regular Expressions
If you check the Regular Expression checkbox, you can then use special symbols — regular expressions — to create a more 
advanced search pattern.

The Norton Commander provides a set of special symbols — regular expressions — that can be used on their own, or combined 
with each other, to create a more advanced search pattern.

These symbols can be used when specifying the name of the file to search for, and when specifying the text to find. When searching
for text, some additional symbols are available to take account of tabs and new lines.

Regular expressions are particularly useful for: 
 Extending the search to take account of many possibilities — similar to the DOS wildcards * and ?.
 Excluding files from a search — such as all files starting with ‘a’ or ‘b’.
 Narrowing the search to a particular range — such as all files containing words that start with any letter between ‘w’ and ‘z’.

Using Long File Names in regular expressions

You can use Long File Names when searching for files. You must put LFNs that include spaces within quotation marks.

Note: The wildcards * and ? are acceptable. However, the characters [ and ] are not, as these are invalid characters in LFNs.

When searching for text, the strings specified in a regular expression are case sensitive.

To find a file using regular expressions:

1 Choose Find File from the Commands menu, or press ALT+F7. The Find File dialog box is displayed.

2 In addition to specifying directories and paths in the Locations text box, you can search the directories and drives specified in 
any environment variable (such as PATH, ROOT, HOME or TEMP).

The variable must be surrounded by the % symbol. For example, to use the PATH environment variable, type in:

%path%

The Norton Commander searches the directories contained in the path statement for the requested files. You can combine drive
locations with any number of environment variables. For example:

c:\dos %path% c:\batch %temp%

Consult your DOS manual for further instructions on using the SET command to create environment variables.

Click here {button ,AL("find;filters;files;expressions")} for related information.



Finding Text Using Expressions
If you want to use regular expressions to find text, you must check the Regular Expression check box (and provide the file 
specification).

The following table shows the various symbols available for use in regular expressions

Click here {button ,AL("find;filters;expressions")} for related information.



Finding Special Characters
If you want to search for a newline in a file or other special characters, you need to understand how these are represented in files. 
Most people think a newline means the start of a new line — in fact, it means “move down to the next line”. To go to the start of the 
line, there must also be a carriage return. 

Therefore, what you typically think of a new line is really made up of two symbols: the ‘\n’ symbol to represent a new line and the ‘\r’ 
symbol to represent the carriage return. Although you can search for these characters separately, you can use the ‘$’ symbol to 
search for the combined symbols.

Click here {button ,AL("find;files;expressions")} for related information.



Splitting Files
To split a file:

1 Select the file you want to split. 

2 Choose Split/Merge from the Files menu, or Press CTRL+F10. The Split File dialog box is displayed.

3 Choose a directory to send your split file to. You can:

 Type the full path and filename for your split file 
 Choose a destination by pressing F10 or clicking on the browse icon for the Tree. You can select a directory by highlighting it and 

pressing Enter.
 Select a previously-used directory from the drop-down listbox.

4 Specify the size of the segments in the Split size textbox. The default size to copy the segments onto high density floppy disk is 
1457664 or the amount of data on the disk, whichever is smaller.

The Norton Commander automatically calculates the number of split segments. Alternatively, you can specify the number of 
segments in the Number of Splits textbox and the segment size is automatically calculated.

5 Check the Delete File After Split checkbox to remove the file from your directory after the file has been successfully split.

6 Press Enter or click on Split to split the file. A number of files with the same name, but with extensions .000, .001, .002 and so 
on, are created. These files are your split files.

Click here {button ,AL("files;merge")} for related information.



Merging Files
To merge split files together:

1 Select at least one of the files you want to merge (the Norton Commander’s Intelligent Merge will do the rest, as long as the files
are in the same directory).

2 Choose Split/Merge from the Files menu or press CTRL+F10. The Merge File dialog box is displayed.

3 Specify the path and the filename you want to give your merged file. You can:

 Type the full path and filename for your split files 
 Choose a destination by pressing F10 or clicking on the browse icon for the Tree. You can select a directory by highlighting it and 

pressing Enter.
 Select a previously-used directory from the drop-down listbox.

The default filename is the name of the split files, without the split extension. If the file names for the split files are different, 
the merged file will take the first name selected.

4 Check the Delete Split Segments After Merge checkbox to remove the split files file from your directory after the files have been 
successfully merged.

5 Click on Merge. The segments are merged into the specified file.

Click here {button ,AL("split")} for related information.



Comparing Files
You often see that two files, often updated copies, are very close in size but not exactly the same. Use the Compare Files facility to 
see what those differences are.

To compare files:

1 Choose Compare Files from the Commands menu.

2 Select the first file you want to compare clicking on the Directory icon to the right of the File 1 pull-down listbox.

3 Type the file in the File Name textbox, or locate the file in the Tree by clicking on it. Then click on Open.

4 Repeat the procedure for File 2.

If you want to compare one file from each panel, the Norton Commander can automatically select them.

To compare files using automatic selection:

1 Highlight the files you want to compare.

2 Choose Compare Files from the Commands menu.

The Norton Commander highlights the text that appears in one file but not the other.

Tip: Maximize the Compare Files window to get a better view of large files.

Click here {button ,AL("files;text;compare")} for related information.



Deleting Files and Directories
You can delete directories and files from the selected drive.

To delete directories and files:

1 Select the directories and files.

2 Choose Delete from the Files menu or click on the Delete icon in the Toolbar or press F8.

Tip: Using drag & drop, you can drag the file to the Windows Recycle Bin. 

3 If you are deleting a directory, and you want to delete all the relevant subdirectories and files, check Include Subdirectories.

4 If you want to perform the operation on files across a complete drive, press SHIFT+F8. For example, you can delete all *.TXT 
files existing on a hard disk, floppy disk, CD-ROM or network drive.

5 Choose a filter from the Use Filters pull-down listbox if you want to use filters in the delete procedure. Or click on the Filters 
button if you want to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

6 Check the Delete Empty Directories checkbox to specify that empty directories are deleted. If this option is left unchecked, the 
contents of the directories are deleted, but the directory structure remains the same.

7 The files and directories as deleted to the Windows Recycle bin as default. If want to delete your files without chance of 
recovery, uncheck the Delete to Recycle Bin checkbox.

8 Press Enter, or click on Delete.

Note: Use the Confirmations option from the General tab of the Configuration dialog box to specify a confirmation prompt before 
copying, moving or deleting files and directories.

Click here {button ,AL("files;filters;folders")} for related information.



Compressing Files
To compress files and directories:

1 Select the directories or files you want to compress. 

2 Press ALT+F5 or select Compress from the Files menu.

3 Choose a directory to send your compressed file to. You can:

 Type the full path and filename for your compressed file 
 Choose a destination by pressing F10 or clicking on the browse icon for the Tree. You can select a directory by highlighting it and 

pressing Enter.
 Select a previously-used directory from the drop-down listbox.

4 If you are compressing a directory, you must check Include Subdirectories.

5 To specify that files are deleted after they are compressed into another file, check Delete files afterwards.

6 To avoid over-writing newer files, check the Compress newer files only checkbox.

7 You can choose a filter from the Use Filters drop-down listbox to specify what files you want to compress. Or click on the Filters 
button to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

8 Commander compression creates ZIP files compatible with PKZIP as default. To specify an alternative compression method, 
choose another Compression Type.

Other compression types supported by the Norton Commander include PAK, ARC and LZH.
If you want to use another compression type on your computer, check the External checkbox.

9 Press Enter or click on Compress. 

Note: If you specified that a password is required for compressing files, you will be prompted for a password. This password is then 
required before the files can be decompressed. Only files compressed using Commander compression can be password protected. 
If you forget the password, the files cannot be decrypted.

Click here {button ,AL("files;filters;compress")} for related information.



Viewing Compressed Files
To view a compressed file:

1 Select the compressed file.

2 Choose Compressed file from the relevant panel menu, or double click the mouse on the file you want to select.

Note: You cannot view individual files compressed with the ARC, ARJ OR PAK compression types. To view the contents of an ARC, 
ARJ OR PAK file, you must first decompress it.

A list of the files contained in the compressed file appears. You can work with this panel list in the same way as you work with any 
file panel. For example, to delete a file from the compressed file list, select the file and press F8.

If you select a file from the contents of the compressed file and copy it, or move it to another location, it is automatically 
decompressed before it is moved or copied.

Click here {button ,AL("compress")} for related information.



Adding Files to a Compressed File
To add files to a compressed file:

1 Open the compressed file that you want to add file(s) to by double clicking with the mouse or highlighting the file and pressing 
Enter. The files in the compressed file are listed.

Note: You cannot browse files compressed with the ARC, ARJ OR PAK compression types. To add to the contents of an 
ARC, ARJ OR PAK file, you must first decompress it.

2 In the other directory panel select the files to add to the file.

3 You can choose to copy (F5) or move (F6) the files into the compressed file panel.

The files are automatically compressed before they are included in the compressed file.

Click here {button ,AL("compress;operations")} for related information.



Decompressing Files
Compressed files on your disk must be decompressed before accessing them. 

Tip: You can use the Rename command (F6) to turn a .ZIP file into a self-extracting .EXE file.

To decompress files:

1 Select the file you want to decompress. 

2 Press ALT+F9 or select Decompress from the Files menu.

3 Choose a directory to send your decompressed file to. You can:

 Type the full path and filename for your decompressed file 
 Choose a destination by pressing F10 or clicking on the browse icon for the Tree. You can select a directory by highlighting it and 

pressing Enter.
 Select a previously-used directory from the drop-down listbox.

4 You can choose a filter from the Use Filters drop-down listbox to specify what files you want to decompress. Or click on the 
Filters button to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

5 If you want to decompress all relevant subdirectories, check Include Subdirectories.

6 To avoid over-writing newer files, check the Decompress newer files only checkbox.

7 Check the Check Target Space checkbox if you want the Norton Commander to warn you if there is not enough space on the 
target disk to store the selected files.

8 Press Enter or click on Decompress to decompress the files.

Note: If you specified a password when compressing the files, you must enter it to decompress the files. If you do not know the 
password the files cannot be decrypted.

Click here {button ,AL("compress;filters")} for related information.



Manipulating Panels
Managing panels

The Norton Commander provides two directory panels. You can decide how you want to display the panels, what files to include in 
the file list and the order in which the files appear. These options are available from the Left and Right menus.

You can work in One Panel mode, or split a panel between itself and an editor or viewer. These options are available from the View 
menu and the Toolbar. You can also re-size a panel by dragging the center bar right or left.

Displaying the panels

The Norton Commander panels can be displayed in four formats: Brief (the default), Full, Tree and Results.

The panel formats for each directory panel work independently. You can display the left panel in Brief format, while displaying the 
right panel in Full format.

Choose the panel format that you want to see from the Left or Right menu.

Press CTRL+U or choose Swap Panels from the Commands menu to swap the panels around.

Adjusting panel sizes

The Norton Commander panels can enlarged or split to suit your needs. The options on the View menu are Two Panels and Split 
Panels. You can re-size panels using the mouse

To display only one panel:

Toggle Two Panels on the View menu (or click the icon on the toolbar). The active panel fills the screen, and the other panel 
disappears. Toggling Two Panels again restores your original display.

To display split panels

Select a file and then select Split panels from the View menu (or click the icon on the toolbar). The file is displayed below the 
directory.

To re-size panels

Move the mouse pointer to center bar in the middle of the screen. When you see the cross-hair, you can drag the center bar right or 
left. Double-clicking on the center bar restores the panels to their default positions.

The default display is Two Panels.

Click here {button ,AL("panels;view;edit")} for related information.



Refreshing Panels
To refresh a panel, choose Refresh from the Left or Right menu, or press CTRL+R. The panel’s display is updated.

Click here {button ,AL("panels")} for related information.



Selecting Drives
To choose a drive:

1 Select Drive... from the Left or Right menus (depending on the panel to be affected).

—Or—

Press ALT+F1 to chose the drive for the left panel or ALT+F2 for the right panel.

—Or—

Select a drive from the Toolbar.

2 Choose the drive you require either by pressing the appropriate drive letter on the keyboard, using the cursor to select the letter 
and pressing Enter, or by clicking with the mouse.

3 The directory panel now lists the files from the drive you chose.

Click here {button ,AL("networks")} for related information.



Mapping Drives
If you regularly use a volume or directory on a server and want to save time accessing that area, you can map a drive on your 
computer to that area.

Windows NT Workstation users should click here for information on mapping drives.

Windows NT Server users should click here for information on mapping drives.

Click here {button ,AL("networks")} for related information.



Mapping Drives on NT Workstations
There are two ways to map a drive to a server. If you are already attached to the server/volume/directory/filename that you want to 
map a drive to, you can choose Map Network Drive from the Disk menu to quickly map the drive. If you want to map a drive to an 
area that you are not attached to, choose Network Utilities from the Disk menu.

To map a drive to an area that you are attached to:

1 Choose Map Network Drive from the Disk menu.

2 The Map Network Drive dialog box is displayed. 

3 Select the drive letter you want to map from the Drive drop-down listbox. Previously mapped drives are displayed in the listbox.

4 Select the path you want to map the drive to from the Path drop-down listbox. The listbox displays all servers and areas that you
are attached to.

Note: If you want to select a path to another area, you can type the path in the listbox. 

5 Type your logon name in the Connect As textbox.

6 Check the Reconnect at Logon checkbox if you want the drive to mapped when you next re-establish your network connection.

7  Click on OK. The selected drive is now mapped to the server, volume and directory.

To map a drive to an area that you are not attached to:

1 Choose Network Utilities from the Disk menu.

2 Double-click on the Network Neighborhood icon to display the list of servers that you are already attached to.

3 Double-click on the Entire Network icon to see a list of network services (e.g., ’Microsoft Windows Network’, ’NetWare or 
Compatible Network’) available on your network.

4 Double-click on a network service to see the list of available servers.

Note: If you select a server that you are not attached to, you must enter a network password.

5  Highlight the volume/directory that you wish to attach to, and choose Map Network Drive from the File menu.

Tip: You can pop up the File menu by right-clicking on the server/volume/directory/filename that you wish to attach to.

6 The Map Network Drive dialog box is displayed. 

7 Select the drive letter you want to map from the Drive drop-down listbox. Previously mapped drives are displayed in the listbox.

8 Type your logon name in the Connect As textbox.

9 Check the Reconnect at Logon checkbox if you want the drive to mapped when you next re-establish your network connection.

10 Click on OK. The selected drive is now mapped to the area.

To access the specified volume or directory, select the drive letter from the Drive Letter list box in the Norton Commander — or 
simply type the drive letter, a colon (:) and press Enter at the DOS prompt.

Click here {button ,AL("networks")} for related information.



Mapping Drives on NT Servers
If you regularly use a volume or directory on a server and want to save time accessing that area, you can map a drive on your 
computer to that area.

To map a drive to any area:

1 Choose Map Network Drive from the Disk menu. The Map Network Drive dialog box is displayed. 

2 Select the drive letter you want to map from the Drive drop-down listbox. Previously mapped drives are displayed in the listbox.

3 Select the path you want to map the drive to from the Path drop-down listbox. The listbox displays all servers and areas that you
have previously attached to.

Note: If you want to select a path to another area, you can type the path in the listbox. 

4 Type your login name in the Connect As textbox.

5 To map the drive permanently, keep the Reconnect at Logon checkbox checked.

6 The list of areas in Shared Directories expands by default to display all computers in your computer’s domain or workgroup. If 
you do not wish to see the expanded list, uncheck the Expand by Default checkbox.

7 Click on OK. The selected drive is now mapped to the server, volume and directory.

To access the specified volume or directory, select the drive letter from the Drive Letter list box in the Norton Commander — or 
simply type the drive letter, a colon (:) and press Enter at the DOS prompt.

Click here {button ,AL("networks")} for related information.



Attaching to a Network Server
The NC Network Utilities makes it easy to attach to a file server. You don't need to know the complex syntax or commands typically 
associated with this process — all you have to do is point and shoot.

To attach to a server:

1 Choose Network Utilities from the Disk menu or select NC Network Utilities from the Windows Programs menu. The NC Network
Utilities dialog box is displayed.

2 Double-click on the Entire Network icon to see a list of network services (e.g., ’Microsoft Windows Network’, ’NetWare or 
Compatible Network’) available on your network.

3 Double-click on a network service to see the list of available servers.

4 Double-click on the Network Neighborhood icon to display a list of servers that you are already attached to. Network 
Neighborhood also displays the computers of other users who have given you share-level access.

5 Highlight the server that you wish to attach to, and choose Attach As... from the File menu. If the server has subdirectories or 
areas, you can double-click on the server and the subdirectories will be displayed. You can attach either to the main server or to 
a subdirectory.

6 The Enter Network Password dialog is displayed. Type the User/Account name and Password in the textboxes.

7 Click on OK.

You are attached to the server, and it is now displayed in the Network Neighborhood list.

Click here {button ,AL("networks")} for related information.



Viewing Server Information
You can obtain general information on different servers, and, if you are a system administrator, you can configure system 
management tools.

To view server information:

1 Choose Network Utilities from the Disk menu.

2 Highlight the server that you want information on.

3 Choose Properties from the File menu, or click on the icon on the NC Network Utilities toolbar. The Server Properties dialog box 
is displayed.

4 The Server information tab provides details on the network system used by the server, current and maximum connections, and 
pass-through servers (if any). 

5 The Tools tab permits system administrators to manage the server using Net Watcher and System Monitor.

Click here {button ,AL("networks")} for related information.



Configuring Norton Commander
The Configuration Options dialog has four tabs: General, Screen, Colors and Compatibility. Each tab has a number of configuration 
options. Here is a brief overview of the tabs, what they feature and what your choices are.
TabFeatures
General Confirmation, editor, compression and auto-save options.
Screen User interface, panel and screen saver options.
Colors Color and font options.
Compatibility Windows/NC mode options: key search, mouse and delete.

Click here {button ,AL("configure")} for related information.



Configuring Confirmation Options
To configure confirmation prompts:

Choose Configuration from the Commands menu. The Configuration Options dialog box appears.

The General tab is displayed as default. Confirmation options are at the top of the tab.

There are four checkboxes. All confirmations are performed as default. Uncheck the actions that you do NOT want confirmations for.
Action If checked
Copy Confirms overwriting any files or directories when copying.
Move Confirms overwriting any files or directories when moving.
Delete Confirms deleting any files or directories.
Exit Confirms exiting from the Norton Commander.

Press Enter or click on OK.

Click here {button ,AL("configure;operations")} for related information.



Configuring Compression Options
You can save disk space by using the Norton Commander to compress your files. You can also specify how Norton Commander 
compresses your files.

To set your compression options:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box appears.

2 The General tab is displayed as default. Compression options are on the lower half of the tab.

3 Setting compression options

If you want to use a password for compressing and decompressing, check the Protect with Password box. If a password is 
specified during compression, the files cannot be decompressed without the password. This option is only available when using 
Commander compression.

4 Press Enter or click on OK.

Click here {button ,AL("configure;compress")} for related information.



Configuring Editors
You can specify any editor you want to use for editing files. The built-in Norton Commander editor is default.

To specify an external editor:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box appears.

2 The General tab is displayed as default. Editor options are on the upper half of the tab.

3 Choose the External Editor radio button.

4 Click on the browse icon to locate your external editor.

5 Click on the program so that it appears in the File name text box.

6 Press Enter or click on Open.

7 Press Enter or click on OK.

Click here {button ,AL("edit;configure")} for related information.



Configuring Screens
To specify that the toolbar is displayed:

Check the Toolbar checkbox in the Screen checkboxes.

The default display for the Norton Commander does not include the toolbar.

To specify that the tab bar    is displayed:

Check the Tab Bar checkbox in Screen options.

The default display does not include the tab bar.

To specify that the status bar is displayed:

Check the Status Bar checkbox in Screen options.

The default display includes the status bar.

To specify that the title bar is displayed:

Check the Title Bar checkbox in Screen options.

The default display includes the title bar.

To specify that the panel status bar is displayed:

Check the Panel Status Bar checkbox in Screen options.

The default display includes the panel status bar.

To specify that the function key bar is displayed:

Check the Key Bar checkbox in Screen options.

The key bar is positioned at the bottom of the screen. You can use the key bar to perform all the important functions in the Norton 
Commander. The key bar operates in four modes when used in conjunction with the Shift, ALT and CTRL keys. For Shift, Alt or Ctrl 
modes, hold down the Shift, ALT or CTRL key when pressing the function key.

To specify that the command line is displayed:

Check the Command Line checkbox in Screen options.

When this option is checked, the full current path is displayed in the DOS prompt.

The default display includes the command line.

To display the clock:

Check the Clock checkbox in Screen options.

The current time is displayed in the lower right corner of your screen.

After you have specified the screen options you want to change, press Enter, or click on OK to save your changes.

Click here {button ,AL("configure;commands")} for related information.



Configuring Panels
The panel options set in the Configuration dialog box apply to both the right and left panels.

To configure your panels:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box is displayed.

2 Choose the Screen tab. Panel options are on the lower half of the tab.

3 Check the options that you want to set.

Check: To:
Show hidden files Specify that hidden files are displayed in panels.
Insert moves down Specify that the insert key moves to the next item on the list.
Select directories Specify that directories are selected when you use *.* (or any valid wildcard expression) to select 

files.
Auto change directories Specify that, when in Tree format, a highlighted directory is automatically selected and the contents 

are displayed in the other panel
Use original case Displays file and directory names in their original case.

4 Press Enter or click on OK to save your changes.

Click here {button ,AL("panels;configure")} for related information.



Configuring Screen Savers
When your screen display is inactive for a long time, the image can “burn” a permanent image onto your screen. To avoid this, the 
Norton Commander blanks your screen and displays a screen saver. You can change the screen saver and choose your own time 
delay.

Press any key to restore the screen image once the screen saver has started.

To configure the screen saver:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box is displayed.

2 Choose the Screen tab. Screen saver options are at the bottom of the tab.

3 Click on the browse icon to locate the screen saver that you want to use.

Note: Screen savers have the extension .SCR.

4 Click on the file so that it appears in the File name text box.

5 Press Enter or click on Open.

6 In the Invoke after __ minutes textbox, specify the number of minutes of idle time before the screen saver switches on.

7 Press Enter or click on OK.

Click here {button ,AL("configure")} for related information.



Configuring Colors
You can change the color of any font or background in a panel, as well as the text and background of the Command Line. You can 
choose any color available with your system.

To set the screen colors:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box is displayed.

2 Choose the Colors tab. Color options are on the upper half of the tab.

3 Click on the item you want to change the color for. You will see the name of the item appear in the Item drop-down listbox. You 
can also select the item from the listbox.

4 Click on the Color box. The palette is displayed.

Tip: You can find additional colors by clicking on the Define Color Button.

5 Click on the color that you want. You will see the selected item’s color change immediately.

6 Repeat the procedure until you have finished configuring your colors.

7 Press Enter or click on OK.

Click here {button ,AL("configure")} for related information.



Configuring Fonts
You can change the font used in the Norton Commander panels. Any font installed on your computer is available.

To change the font:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box is displayed.

2 Choose the Colors tab. Color options are on the upper half of the tab.

3 Click on the Change Font button. The Font dialog box is displayed.

4 Choose the font that you want to use, along with a style and point size.

5 Click on OK.

6 Press Enter or click on OK again.

Click here {button ,AL("configure;text")} for related information.



Configuring the Mouse
By default the Norton Commander uses a right-handed mouse: the left button points and the right button selects. You can switch to 
a Windows-style mouse, so that the button actions work differently: the left button selects and the right button pops up a menu with 
useful items from the Files and Commands menus.

To specify a Windows-style mouse:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box is displayed.

2 Choose the Compatibility tab. Mouse options are on the lower half of the tab.

3 Check the Right click pops up menu radio button.

4 Changing the mouse to Windows mode

5 Press Enter or click on OK.

Your mouse now selects with the left button and displays a pop-up menu with the right button.

Click here {button ,AL("configure")} for related information.



Configuring Speed Search
The Norton Commander’s speed search uses the keyboard to quickly select a file in a panel.

To change speed search mode:

1 Choose Configuration from the Commands menu. The Configuration Options dialog box is displayed.

2 Choose the Compatibility tab. Speed search options are on the upper half of the tab.

3 Set the Norton Commander’s speed search to work in the following ways:

CTRL+ALT (default)
ALT (overrides Windows standard)
First letter (overrides the DOS Prompt)

4 Press Enter or click on OK.

Click here {button ,AL("configure;find")} for related information.



Creating Directories
You can create a directory anywhere on your drive.

To create a directory:

1 Choose Make Directory from the Files menu, or press F7.

2 In the Make Directory text box, type the name of the directory you want to create. If you do not precede the directory name with 
a pathname, the directory is created in the current directory.

3 Press Enter.

Click here {button ,AL("folders;operations")} for related information.



Copying Directory Structures
An alternative method of creating a directory is to copy a directory — and its subdirectories — when in tree mode. In this way you 
can reflect a directory structure without having to create all the directories and subdirectories. 

For example, if you want to create the same directory structure for your word processing files on a monthly basis:

1 Create a directory for JANUARY. 

2 Make a subdirectory called DOCS, with subdirectories for MEMOS, LETTERS and PLANS. 

3 Now create a directory for FEBRUARY. 

4 Highlight the DOCS directory, hold the left mouse button down and drag DOCS to FEBRUARY. 

5 The Copy dialog appears. Click on the Copy button, or click on the Tree icon to choose another directory.

6 Your FEBRUARY directory now has the same directory structure as your JANUARY directory.

Click here {button ,AL("folders;operations")} for related information.



Comparing Directories
You often need to compare the files in a directory before copying or deleting files. Use the Compare Directories facility to determine 
which files you want to keep.

To compare directories:

1 Select the directories you want to compare in the Left and Right panels.

2 Choose Compare Directories from the Commands menu.

The Norton Commander selects, or tags the files that appear in one directory but not the other. Additionally, it selects any files 
created or modified more recently than their counterparts in the other directory.

Click here {button ,AL("compare;synchronize;folders")} for related information.



Synchronizing Directories
There are many occasions when you need to have two directories identical — that all the files in one directory are the same as the 
files in the other — for example if you want to ensure that all the files on your portable are the same as the files on your desktop 
machine.

To synchronize directories:

1 Display the directories you want to synchronize in the left and right panels. The directory in the active panel is the source 
directory, and the directory in the other panel is the target directory.

Note: To synchronize directories from one computer to another you need to connect the computers using the Link option.

2 Choose Synchronize Directories from the Commands menu to display the Synchronize Directories dialog box.

3 Choose a filter from the Use Filters pull-down listbox if you want to use filters in the copy procedure. Or click on the Filters button
to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

4 Check your other synchronization options:

Check To
Include Subdirectories Synchronize the contents of subdirectories.
Matching Files Only Update only the files which exist in both directories. If this option is checked, new files are not copied 

into the panels.
Update Target Only Specify that files are copied to the target directory only.

5 Click on the Synchronize button to start the Synchronization procedure.

6 The list of files to be copied from one directory to another is displayed. The arrow indicates the direction a file is to be copied. If 
the file does not exist in a directory it is marked as a New file. If a file exists, but file time or date is different, the new time and 
date is displayed.

7 You can select or deselect files from the list using the Select/Deselect button or by clicking on the file with the secondary mouse 
button. 

8 Click on Synchronize to synchronize both directories. 

Note: Blank directories are not included in synchronization procedure.

Click here {button ,AL("folders;compare;filters")} for related information.



Changing File Attributes
To change the attributes for a file or a group of files:

1 Select the files.

2 Choose File Attributes from the Files menu. The Set File Attributes dialog box appears.

You can set or clear attributes for the selected files. Choose the attributes you want to specify.
Choose To specify that
Read-only The file can be read    but it cannot be modified
Archive The file is to be backed up during the next DOS back up
System The file is part of the operating system
Hidden The file is listed in a panel but not in a DOS screen

3 Check the Include Subdirectories checkbox if you want the attributes of files in the selected subdirectories to be changed.

4 Choose a filter from the Use Filters pull-down listbox if you want to specify filters for setting attributes. Or click on the Filters 
button to create a custom filter. For more information on using filters, click here {button ,AL("filters")}.

5 Press Enter, or click on Set Attributes.

Tip: When you copy files from a CD-ROM, the files are marked read-only. You can use the File Attributes function in the Norton 
Commander to clear the read-only attribute from all files — including directories and subdirectories.

Click here {button ,AL("files")} for related information.



Using Operations Filters
Operations filters are used when performing actions such as:
 Copying files
 Moving or renaming files
 Deleting files
 Compressing and decompressing files
 Setting file attributes

These filters are accessed by clicking on the Filters button when performing one of the operations listed above. They work 
independently of panel filters specified from the Left or Right menus.

Example: Copying files using an operations filter

Imagine you want to copy all of the *.HLP files in the Norton Commander directory created in March 1996:

1 Select all the files in the panel — you can use the panel filter already in place.

2 Press F5. The Copy dialog box is displayed.

3 Click on the Filters button to display the Filter Setup dialog box.

4 Filter Setup dialog box - Name & Attributes tab

5 The Filter Setup dialog box has four tabs: Filter, Name & Attributes (default), Containing, and Date & Size. In the Include textbox 
in the Name & Attributes tab, type:

*.hlp
6 In the first File Date Between textbox in the Date & Size tab type:

1/3/96
7 In the second box type:

31/3/96
8 Click on OK or press Enter to return to the Copy dialog box.

Click on Copy. The files that meet the criteria specified are copied to the directory specified in the Copy dialog box.

Click here {button ,AL("filters;operations")} for related information.



Using File Filters
The Norton Commander has a number of pre-defined file filters for use in commonly performed searches. These are Executable, 
Database, Spreadsheet, Word Processor, Graphics and Compressed file filters. Each filter has a default filter specification which 
you can use as is, or modify to suit your own preferences. You can also create your own custom file filters.

To use a filter:

1 Choose Filter... from the Left menu

—Or—

Click on the Filters button in the Copy, Rename/Move, Delete, Compress or File Attributes dialog boxes.

2 Choose the Filter tab. A list of available filters is displayed.

3 Choose the filter you want to use.

Note: You can modify the specifications for this filter.

4 Click on OK or press Enter to implement the filter.

Click here {button ,AL("filters;files;panels")} for related information.



Creating Custom Filters
Custom filters can be created from the Left or Right menus, or from the operations dialog boxes — such as copy, delete, or 
compress. The filter you create is available for both operations and panels.

Creating a custom filter:

1 Choose Filter... from the Left or Right menu to display the Filter Setup dialog box.

2 Specify the files you want to include in your filter specification - by Name, Date, Size, Attribute, Type and/or Contained text.

3 Choose the Filter tab. 

4 Choose an unassigned Custom filter — listed on the right side as Custom #1, #2, and so forth.

5 Type a descriptive name in the Filter Name textbox. This filter will now be available when you need to use it again.

6 Click on OK or press Enter.

The left panel displays files that match the filter specifications. Note that the title bar now contains the name of the filter you have 
created.

Click here {button ,AL("filters")} for related information.



Specifying File Filters
When using the Filter Setup dialog, you can a use combination of categories to create a filter specification:
For Go To
File Name(s) The Name & Attributes tab
File Attribute(s) The Name & Attributes tab
File Size The Date & Size tab
File Date The Date & Size tab
Text contained in the file The Containing tab

File Name(s)

This option determines which files are included or excluded when using the filter. To specify a number of file names or types, 
separate the file specifications with a semi-colon (;) or a space. 

File Attribute(s)

If you check multiple attribute boxes, files will not be considered a match unless each of the checked attributes is set.

File Date

Use the Date category to filter files based on the dates and times they were last modified.

Tip: You can specify files modified before or after a particular date by leaving one or the other of the Between textboxes empty. For 
example, “Between 10/10/95 9.00 and [EMPTY TEXTBOX]” would include all files modified after 10 October 1995.

You can also customize your filter to include files modified during the previous x hours, days, weeks, and so on. Click the During 
Previous button to choose this option.

File Size

Use the Size category to filter files based on their size (in bytes). If you want to specify merely above or below a certain size, leave 
one or the other textbox empty. For example, “Between 5000 and [EMPTY TEXTBOX]” would include all files larger than 5000 bytes
(5K).

Contained text

Use the Text category to filter text files based on their contents. If you want to specify merely what text string you are looking for, 
simply enter the text in the Text drop-down listbox.

If you want to specify case in a text string, check the Case sensitive checkbox.

If you want to use a regular expression to find variations on a text string, check the Regular expression checkbox.

If you want to limit your filter to text files only, check the Text files only checkbox.

Click here {button ,AL("filters;text")} for related information.



Browsing Image Files
The Norton Commander handles image files much in the same way as compressed files, i.e., it treats an image file as a directory. 
You can view the contents of an image file by double clicking on the file with the mouse.

To view an image file:

1 Select the image file.

2 Double click the mouse on the file you want to view.

A list of the files contained in the image file appears. You can work with this panel list in the same way as you work with any file 
panel. For example, to delete a file from the compressed file list, select the file and press F8.

Click here {button ,AL("view;image")} for related information.



Creating a User Menu
You can specify a hotkey to execute programs or commands. The hot key can be any text key or CTRL plus any key, for example, W
or CTRL+W.

To create a user menu:

1 Press F2 or choose User Menu from the Files menu.

—or—

Choose Menu File Edit from the Commands menu.

2 Press the Insert key or click on the Insert button. You can insert a command or a submenu.

3 In the Type box, choose the Submenu radio button.

4 Type any text key or CTRL plus any key in the Hot Key textbox as the hot key for a submenu.

5 Type the submenu name in the Title textbox as the menu label. This name appears as an item on the user menu.

6 Click on OK to accept the details entered.

7 Now specify what programs are to be on the submenu. Highlight the submenu’s name and click on Modify. The Submenu dialog 
box appears.

8 Press the Insert key or click on the Insert button.

9 Type a hot key, a label and the required commands to launch the database.

10 Click on OK to accept the details entered.

11 Click on OK again to save the changes to the nc.mnu file.

Click here {button ,AL("configure;commands")} for related information.



Adding a Command to a User Menu
You can specify a hotkey to execute programs or commands. The hot key can be any text key or CTRL plus any key, for example, W
or CTRL+W.

To add a command to the User menu:

1 Choose User Menu from the Files menu, or press F2.

2 Press the Insert key or Click on the Insert.

3 In the Type box, choose the Command radio button.

4 Type a hot key, a label and the command.

5 Click on OK to accept the details.

6 Click on OK again to save the changes to the nc.mnu file.

To run any of the commands or programs added to the user menu, press F2 (User Menu) and choose from the list displayed, or 
press the hot key displayed beside the menu label.

Click here {button ,AL("configure;commands")} for related information.



Copying Disks
Using the Copy Disk command you can copy data from one disk to another. You can copy between two floppy disks without copying 
to your hard disk first.

To copy a disk:

1 Choose Copy Disk from the Disk menu to display the Copy Disk dialog box.

2 Copy Disk dialog box

3 Click on OK to start the copy procedure.

4 Insert the source disk into your floppy drive, and click on OK. The data is copied from the disk.

5 When prompted, insert the destination disk into the floppy drive and click on OK.

The data from the source disk is copied onto the destination disk.

Click here {button ,AL("copy;disks")} for related information.



Formatting Disks
Before you can use a disk for storing files it must be formatted. The Norton Commander provides a fast and efficient disk format 
utility.

To format a disk:

1 Insert a disk into the floppy drive.

2 Choose Format Disk from the Disk menu.

3 Choose a drive for formatting. If you have only one floppy drive, this drive is automatically selected. Click on OK. The Format 
dialog is displayed.

4 You can specify a floppy disk size. The default size is the maximum capacity of the drive.

5 Choose a file system. To format the disk with another file system, choose on from the File System drop-dowm listbox.

6 Choose a disk allocation unit size. Use the Default Allocation Size unless you are an experienced user with special 
requirements.

7 Enter a volume label (name) of up to eleven characters for your disk.

8 The following options are available:

Option Action

Quick Format Check this checkbox to re-format a disk that has already been used. Quick Format does not check for
bad sectors.

Enable compression Check this checkbox so that all files and directories on this disk will be compressed.

1 Click on Start to begin formatting.

2 Click on Close to finish formatting, or insert another disk.

Click here {button ,AL("disks")} for related information.



Labeling Disks
You can specify a label for the disk displayed in the active panel.

To label a disk:

1 Choose Label Disk from the Disk menu to display the Label Disk dialog box.

2 Type a label for the disk. Labels can be up to 11 characters.

3 Click on OK.

Click here {button ,AL("disks")} for related information.



Cleaning Up Disks
To tidy up your disk:

1 Choose Disk Cleanup from the Disk menu. The Disk Cleanup dialog box is displayed.

2 Choose the type of files you want to delete, by checking these templates:

Choose To
Temporary files Delete all temporary files
Backup files Delete all backup files
Misc. Development files Delete development files that you no longer need
README Type files Delete readme files
Old AUTOEXEC files Delete old AUTOEXEC files
Old CONFIG files Delete old CONFIG files
Old Windows INI files Delete old Windows INI files
Windows Std. Mode files Delete files necessary to run Windows in standard mode. Only choose this filter if you never

intend running Windows in standard mode.
Product Installers Delete installation or setup files which were copied onto your hard disk. Does not delete 

files in \WINDOWS, \NDW, \DOS, \BIN or \BRIEF.
Compressed filesDelete compressed files.
Custom #11 & #12Specify your own criteria for deletion

3 You can specify what files are included in each cleanup filter using the Define button.

4 Select the drive you want to work with in the Current drive drop-down listbox.

5 Choose Start to begin the process.

All the files that meet the delete criteria are displayed in the file listbox. You can deselect files from this list by pressing CTRL and 
clicking on the file name.

6 Choose Delete to delete the files — or choose Send to Panel to send the files to a Results panel.

Note: Files sent to a Results panel can be worked with in the same way as files in all other panel formats.

Click here {button ,AL("disks;cleanup")} for related information.



Using Cleanup Filters
You can specify the types of files to be included in each cleanup filter— *.tmp files in the Temporary files filter, *.bak files in the 
Backup files filter.

To define a cleanup filter:

1 Click on the Define button in the Disk Cleanup dialog box. The Define Cleanup Filters dialog box is displayed.

2 Select the cleanup filter you want to define from the Filter tab.

3 In the Location(s) textbox specify the possible location or locations of the file — the default is the directory or regular expression 
shown in the textbox.

Tip: Press F10 to display the contents of the current drive in a tree format

4 When using the Define Cleanup Filters dialog, you can a use combination of categories to create a filter specification:

For Go To
File Name(s) Go to the Name & Attributes tab
File Attribute(s) Go to the Name & Attributes tab
File Size Go to the Date & Size tab
File Date Go to the Date & Size tab
Text contained in the file Go to the Containing tab

5 Click on OK to save the definition for this cleanup filter.

Click here {button ,AL("disks;filters")} for related information.



Viewing the NCD Tree
The NCD Tree is a popup version of the Tree format. The NCD Tree pops up over existing directory panels without disturbing the 
panel set-up. 

To display the NCD Tree:

1 Choose NCD Tree from the Commands menu or press ALT+F10.

A directory tree of the current drive is displayed with the current directory highlighted. To change directories, use the arrow keys 
to highlight the directory you require. Alternatively you can use the speed search feature. For example, to move to the SHOTS 
subdirectory, start typing the first letters of the directory name. The cursor moves to the first directory name that matches the 
string you have typed. If the highlighted directory is not the one you require, press CTRL+Enter to highlight the next match.

Tip:  Pressing CTRL and the + key or CTRL and the - key expands or collapses a directory. Pressing CTRL and the * key 
expands all subdirectories below the highlighted directory.

2 When you have highlighted the directory required, press Enter. The directory panels replace the NCD Tree. The directory 
highlighted on the NCD Tree becomes the current directory on the active panel.

There are a number of key commands available with the NCD screen:
Command Key Action
Rescan F2 Rescans the current disk and rebuilds the Tree.
Rename F6 Allows you to rename the highlighted directory.
MakeDir F7 Creates a subdirectory of the highlighted directory.
Delete F8 Deletes the highlighted directory. You cannot delete the current directory, on the active directory 

panel.
Quit F10 Quits the NCD Tree and returns you to the Norton Commander directory panels.

Tip: You can use the key bar as well as the Function keys.

You can also use the CTRL keys to expand or collapse directories in the tree.
 CTRL and the + key expands the highlighted directory.
 CTRL and the - key collapses the highlighted directory.
 CTRL and the + key expands all subdirectories in the highlighted directory.

Click here {button ,AL("folders;find;commands")} for related information.



Displaying Panels
The Norton Commander provides two directory panels. You can decide how you want to display the panels, what files to include in 
the file list and the order in which the files appear. These options are available from the Left and Right menus.

You can work in One Panel mode, or split a panel between itself and a viewer. These options are available from the View menu and 
the Toolbar. You can also re-size a panel by dragging the center bar right or left.

Displaying the panels

The Norton Commander panels can be displayed in four formats: Brief (the default), Full, Tree and Results.
Format Result
Brief Displays a list of directories and files on the selected drive. If you select a directory, the subdirectories and 

files in that directory are listed. File information about each highlighted file is displayed in the mini-status line
at the bottom of the panel.

Full Like the Brief format, it displays a list of directories and files on the selected drive. Additionally, the size, 
date, time and attributes of each file are shown in adjacent columns. 

Tree Displays the directory tree for the current drive. If, for example, you select the Tree format from the Left 
menu, a directory tree for the right panel is displayed. As you scroll through the directory tree in the left 
panel, the files contained in each directory are displayed in the right panel. You can expand or collapse 
directories by double-clicking on them. The directory highlighted in the tree panel becomes the current 
directory.

Results Displays a list of files found when you use the Find File command from the Commands menu. You must 
select the Send to Panel button on the Find File dialog box to create the list of files found. This list of files is 
saved until the next time you run Find File. You can handle files in the Results panel in the same way as in 
other panel formats.

The panel formats for each directory panel work independently. You can display the left panel in Brief format, while displaying the 
right panel in Full format.

Note: Press CTRL+U or choose Swap Panels from the Commands menu to swap the panels around. 

Adjusting panel sizes

The Norton Commander panels can be enlarged or split to suit your needs. The options on the View menu are Two Panels or Split 
Panels. You can re-size panels using the mouse. The default display is Two Panels.
Display Result
One Panel Displays the active panel over the whole screen. This is useful when you are viewing a large directory and 

want to see as much as possible. If you toggle Two Panels on the View menu (or click the icon on the 
Toolbar), the active panel fills the screen, and the other panel disappears. Toggling Two Panels again 
restores your original display.

Split Panels Displays a selected file with a viewer over the bottom-half of the active panel. Select a file and then select 
Split panels from the View menu (or click the icon on the Toolbar). The file is displayed below the directory.

Re-size Panels Displays two panels in any proportion. You can get a bigger view of one panel but still retain a glimpse of 
the other. Move the mouse pointer to the center bar in the middle of the screen. When you see the cross-
hair, you can drag the center bar right or left.

Click here {button ,AL("panels;select")} for related information.



Using Commander Link
You can also copy and move large groups of files between two computers with Commander Link. The two computers must be 
connected using a Commander cable via the serial or parallel ports. This is useful for transferring files from your laptop to your 
desktop computer.

Tip: For faster transfer speeds, use parallel ports.

To transfer files:

1 Connect the two computers with a Commander cable, via the serial or parallel ports.

Caution: Do not mix the ports on the machines, if you use the parallel port on one machine, you must use the parallel port on 
the second machine.

2 Choose Scan for Connection from the Commands menu on both computers. If you have the status bar displayed, a Link: 
message will appear once a successful connection has been made.

3 Select the port that the Commander cable is attached to.

4 Choose Link from the Left or Right menu on either computer. The current directory of the computer you are linked to is displayed
in active panel of the computer you chose the Link command on.

5 You can work with the files and directories in the two panels in the same way as you work with two panels for the same 
computer. For example, to copy a file from one computer to the other,

6 Select the file.

7 Choose Copy from the Files menu.

8 Press Enter or click on Copy.

9 A copy of the file now exists on the master computer.

10 When you have finished working with the files, choose the Link command again to return your panel to the local directory.

11 To terminate the connection between the two computers, choose Scan for Connection again from the Commands menu on both 
computers.

Click here {button ,AL("operations")} for related information.



Creating Image Files
An Image file is an exact copy of a disk — sector for sector, byte for byte. The Norton Commander allows you to create an Image file
and store it on your hard disk. You can copy the Image file at a later stage and have an exact copy of a disk.

To create an Image file:

1 Insert your source disk into the floppy drive.

2 Choose Copy Disk from the Disk menu to display the Copy Disk dialog box.

3 Select your floppy drive in the Source group box.

4 Select Image File in the Destination group box.

5 Specify a name and path for your Image file. Or choose a path by clicking on the Directory icon and using the tree, and click on 
OK.

6 Click on OK to create your Image file.

7 Insert the source disk into your floppy drive, and click on OK. An exact copy of your disk is placed on the hard disk.

Click here {button ,AL("disks;copy;image")} for related information.



Copying Image Files
An Image file is an exact copy of a disk — sector for sector, byte for byte. The Norton Commander allows you to create an Image file
and store it on your hard disk. You can copy the Image file at a later stage and have an exact copy of a disk.

Copying an Image file:

1 Choose Copy Disk from the Disk menu to display the Copy Disk dialog box. 

2 Select Image File in the Source group box and click on OK to display the Select File dialog box.

3 Type the name and path of the Image file. Or choose a path and a file by clicking on the Directory icon and using the tree, and 
click on OK.

4 Click on OK. You are prompted to insert the destination disk. Insert the disk and click on OK. The contents of the Image file are 
copied onto the destination disk.

Note: If you use F5 (Copy) or drag & drop to copy the Image file, then a copy of the Image file is made. This is not the same as 
using the Copy disk command, which undoes the imaging process and creates an exact replica of the source disk.

Click here {button ,AL("disks;copy;image")} for related information.



Getting Started
To launch the Norton Commander, click on Start and go to the Programs menu. On the Programs menu, go to Norton Commander 
and select it. The Norton Commander displays two directory panels. The files listed in the panels are the files contained in the 
current directory.

Getting help

The Norton Commander provides Online Help for all the panels and dialogs. There are four ways to access the Help. 

To see the main Online Help contents, index, and full text search:

Choose Contents from the Help menu, or press F1.

The Help Contents appears. If you want to look at the index, click on the index tab. If you want to search the text of the Help for a 
particular term or terms, click on Find and follow the instructions.

To see task- and context- oriented Help:

Click on the Help button in a dialog box.

The relevant Help topic (or a list of topics) appears.

—Or—

Right-click on a dialog box.

A pop-up menu appears with three items: What’s This? (information about the dialog), How to (task-oriented Help) and Contents 
(the Help Contents).

Windows features What's This? context help for items in dialog boxes and on the desktop. As you use the Norton Commander, right-
click on any item in a dialog box to bring up this context menu.

Exiting the Norton Commander

When you have finished working with the Norton Commander, you can exit by a number of ways. You can:

Choose Exit from the Files menu.

—Or—

Press F10.

—Or—

Double-click on the Commander icon in the upper left-hand corner.

—Or—

Click on the X button in the upper right-hand corner.

Any one of these methods displays a confirmation dialog box, unless you have changed your Confirmation options in the 
Configuration dialog box. Choose Yes to exit.

Click here {button ,AL("start;welcome")} for related information.



Adding or Editing File Extensions
An association tells the Commander which application to run when you choose a particular file type. To tell the Commander which 
application to run on a selected file, you may have to create (or edit) the extension file, nc.ext. The extension file associates the 
extension to the appropriate program. Besides recognizing Windows file associations, you can add new associations or edit existing 
ones as well.

To create a new file association or edit an existing association:

1 Choose Edit Associations from the Commands menu. The Associations dialog appears.

2 Click on the Add button, or, if you want to change an extension, highlight the type of file you want to make a new association for 
and then click on the Edit button.

3 The Add/Edit Association dialog appears. In the Extension textbox, type the file extension, for example, .dtf. There is no need to 
type in the period that precedes the extension.

4 In the Association textbox, type the command for the application, or click on the browse icon to locate it.

5 Type a description of the file type in the Description textbox.

6 Click on OK to return to the Associations dialog. 

7 Click on OK again to save the changes to the extension file.

Tip: If you point and shoot at a file with no application associated with it, the Norton Commander will ask you which application you 
want to use to open the file. If you don’t see the application on the list, click on the Other button and choose another one. If you want
to make the association permanent, check the Save this association checkbox.

Click here {button ,AL("files;associate")} for related information.



Symantec Service and Support Solutions 
Symantec offers a variety of technical support and customer services to meet your needs. Our Technical Support department offers 
several different levels of support to assist you with specific questions you may have in using our software. Our Symantec 
Information Centre department will inform you what Symantec has to offer and how to get what’s available.
 Registering Your Symantec Product
 Technical Support
 StandardCare Support
 PremiumCare Platinum Support
 Electronic Support
 Symantec BBS
 CompuServe
 Automated Fax Retrieval System
 Symantec Information Centre
 Symantec International Locations



Registering Your Symantec Product
To register your Symantec product, complete the registration card included with your package and drop the card in the mail.

The Address you should use is on the enclosed sticky labels. The card should be mailed to the nearest geographical address to you,
if no office is available in the same country. Alternatively mail to the address below.

Symantec Ltd.,
European Headquarters
PO BOX 1345
2302 B4 Leiden
The Netherlands

Fax: +31 (0)71 535 3153



Technical Support
Symantec’s Technical Support department offers expanded support options designed for your individual needs and to help you get 
the most out of your software investment.

Symantec now offers different types of technical support services for you to choose from. You are given StandardCare Support by 
purchasing the product and then can choose to extend your level of support with PremiumCare Platinum Support .

Please call the local Symantec office or distributor in your area, or refer to the international offices.



StandardCare Support
All registered users of Symantec products are entitled to these services at no charge:

1 Unlimited calls for 90 days (from date of first call) for installation assistance, configuration, and general usage questions.

2 Unlimited technical assistance via CompuServe and America Online. These forums offer electronic access to 
our technical support staff, libraries of sample files, technical notes, and bulletins. You will also find a rich interaction and information
exchange with other users of Symantec software.
3 Unlimited use of Symantec’s Bulletin Board System (BBS). This download BBS is kept updated with sample 
files and product technical notes for quick and easy electronic access.

4 Unlimited access to company information via the Internet. With an Internet browser program such as Mosaic, Cello, or 
Netscape, you get the latest company news by entering Symantec’s Internet address: http://www.symantec.com.

5 Unlimited use of Symantec’s automated fax retrieval system for instant printouts of technical notes, bulletins, 
product literature, and general information by fax.

The Web pages include links to our anonymous FTP site, where you can download the latest software patches and drivers for 
Symantec products. You can also FTP directly to the site by entering: ftp.symantec.com.

1 Unlimited use of Symantec’s automated fax retrieval system for instant printouts of technical notes, bulletins, product 
literature, and general information by fax.

2 StandardCare Support is available Monday through Friday, 09:00 am to 5:00pm CET.



PremiumCare Platinum Support
1 Unlimited calls on a toll-free line.

2 Average hold time will be kept to a minimum.
3 A Support Center Manual with troubleshooting, installation, configuration, and usage information.
4 Quarterly updates of technical notes and bulletins.
5 Instant access to senior support staff.
6 Automatic updates of inline software revisions. (Inline software revisions do not include version upgrades.)

7 After hours and weekend support is also available to PremiumCare Platinum customers for an additional fee.

8 PremiumCare Platinum Support is charged on an annual subscription basis per product family. The annual fee 
is for two subscribers; other subscribers can be added on a per person basis.
9 PremiumCare Platinum Support is available Monday through Friday, 09:00am to 6pm CET.

To order PremiumCare Gold or Platinum support, please contact Symantec Information Centre or your Symantec sales 
representative. 



Electronic Support
Technical information is available 24 hours a day on electronic bulletin board systems. Symantec provides access to its own 
Symantec bulletin board system (BBS), and maintains the Symantec forums on CompuServe and America Online.



Symantec BBS
The Symantec BBS provides a Customer Service forum, shareware and public-domain software, “Frequently Asked Questions” 
(FAQs), and support forums where you can exchange tips and information with other users. Settings for the Symantec bulletin board
are: 8 data bits, 1 stop bit; no parity, and baud rates from 300 to 28.8K are available.

300- through 14,400-baud modem +31 71 535 3169
300- through 28,800-baud modems + 31 71 532 2852



CompuServe 
You can exchange information and ideas with Symantec representatives and with other users of Symantec products on the 
CompuServe bulletin board.

To access the Symantec forums on CompuServe, type:

GO SYMANTEC at any ! prompt.

To access the Symantec-Europe forum on CompuServe, type:

GO SYMEUR at any ! prompt.



Automated Fax Retrieval System
Symantec’s automated fax retrieval system can be used 24 hours a day to receive product information on your fax machine. You 
can call from any touch tone phone to receive an index listing of both Technical Support and Customer Service documents available,
then have any of these specific documents faxed to you. 

To receive technical application notes and samples of “how tos,” please call our Technical Support fax retrieval number, and choose
Option 2.

You can receive general product information, data sheets, and product upgrade order forms from our Symantec Information Centre 
fax retrieval number.

European Fax Retrieval    Numbers
UK +44 1 628 777 435
Germany +49 211 676 115
NL +31 71 535 3255

In addition, you can receive a listing of Symantec offices and worldwide service and support partners by calling the Technical 
Support fax retrieval number, choosing Option 2, and requesting Document 1400.



Symantec Information Centre
Symantec’s Information Centre builds and maintains long-lasting customer relations through consistent, expert service. Our 
Symantec Information Centre is available to help you:

1 Order an upgrade.

2 Subscribe to the technical support solution of your choice.
3 Fulfill your request for product literature or demonstration disks.
4 Find out about dealers and consultants in your area.
5 Replace missing or defective pieces (disks, manuals, etc.) from your package.
6 Let us know if the address on your registration card has changed. 

Customer Service in Germany

International Customer Service 



Customer Service - Germany
Symantec Ltd.,
European Headquarters
PO BOX 1345
2302 B4 Leiden
The Netherlands

Tel: (31) (71) 535 3111
Fax: (31) (71) 535 3150
Automated fax retrieval (voice menu)
Tel. (31) (71) 535 3255

Technical Support:
Tel          (49) (211) 991 7110
Fax        (31) (71) 535 3153

Click here for international locations.



Symantec International Locations
Symantec provides technical support and customer service worldwide. If you’re in a country outside of the United States or Canada,
please contact the local distributor or Symantec office nearest to you, or our world headquarters.

1 World Headquarters

2 European Headquarters



World Headquarters
Symantec Corporation
10201 Torre Avenue
Cupertino, CA 95014
USA

Tel. (408) 253-9600



European Headquarters
Symantec Europe
Kanaalpark 145
2321 JV Leiden
The Netherlands

Tel: (31) (71) 535 3111
Fax: (31) (71) 535 3150
Automated fax retrieval (voice menu)
Tel. (31) (71) 535 3255

Technical Support
Dutch Tel. (31) (71) 579 4407
French PC/Mac Tel. (33) (1) 41 38 69 80
German Tel. (49) (211) 991 7110
English Tel. (44) (1628) 788 580

Fax Tel. (31) (71) 535 3153
BBS Tel. (31) (71) 535 3160
or Tel. (31) (71) 535 3169

Other Countries Tel. (31) (71) 579 4425

Fax (31) (71) 535 3153

Windows 95 - Delrina Fax Tel. (31) (71) 524 7270
(Winfax)

International English Tel. (31) (71) 524 7210 

Delrina Fax(Winfax) Tel. (31) (71) 524 7271
/DOSFax/Faxpro for Mac

International English Tel. (31) (71) 524 7211

CommSuite/Wincomm/Cyberjack/
pcANYWHERE 32 Tel. (31) (71) 524 7272

International English Tel. (31) (71) 524 7212

Screen savers/Echo Lake Tel. (31) (71) 524 7273

International English Tel. (31) (71) 524 7213

FormFlow/perForm Tel. (31) (71) 524 7274

International English Tel. (31) (71) 524 7214

Fax (31) (71) 524 7295

Registration Fax (31) (71) 524 7299

International BBS Tel. (31) (71) 535 3169
(up to 14.4 baud)
BBS SAM Virus Tel. (31) (71) 535 3299
Definition Update



This dialog is for copying files or directories.



Check these options if you want them to be enabled.



This dialog is for moving files or directories.



Check these options if you want them to be enabled.



This is the file editor.



This dialog is for finding files.



Narrow your search by choosing the area to look in.



Check these options if you want them to be enabled.



This dialog is for splitting files.



This dialog is for merging files that have been split.



This dialog is for comparing files.



This dialog is for deleting files.



Check these options if you want them to be enabled.



This dialog is for compressing files.



Check these options if you want them to be enabled.



Choose the type of compression you want to use.



This dialog is for decompressing files.



Check these options if you want them to be enabled.



Choose the drive you want to be displayed in the panel.



Choose the drive letter and path for the drive you want to map.



Choose the network server that you want to attach to.



Set your configuration options here.



If confirmation options are checked, a requester will appear when you perform the specified action.



Check this option if you want to protect your compressed files with a password.



Choose your default editor here.



Checking these options displays the items in the Norton Commander.



Checking these options changes the way Norton Commander panels display files and directories.



Choose your screen saver here.



Choose the colors and fonts you want displayed in the Norton Commander panels here.



Choose the way you want speed search to work: by holding down CTRL+ALT (Norton Commander default), ALT (as in Norton 
Commander for DOS), or nothing (the DOS prompt is over-ridden).

To change the mouse so it works more like Windows, choose "Right click pops up menu".

To delete a file so that it cannot be recovered, uncheck the Delete to Recycle Bin checkbox.



Choose a name for your new directory.



Choose the directory you want to be synchronized with the active panel.



Check these options if you want them to be enabled.



These files are in the source directory, but not in the target directory.



These files are in the target directory, but not in the source directory.



This dialog is for changing file attributes.



Check these file attributes to assign them to the selected files and/or directories.



Check these file attributes to remove them from the selected files and/or directories.



Check these options if you want them to be enabled.



This dialog is for filtering your panels, operations or disk cleanup.



These are different types of pre-defined filters that you can use. You can define the "Custom" filters yourself.



Choose the filename(s) that you want to include or exclude in your filter. You can use the wildcards * and ?.



Check the file attributes you included in your filter.



Type text that must be in files to be included in your filter. Check the text options if you want to enable them.



Specify time parameters for your filter.



Specify size parameters for your filter.



This is your user menu. Click on Insert to add an item to it.



Choose a hot key and name for the submenu, or a hotkey, name and command for a command.



This dialog is for copying disks or image files.



Check these options if you want them to be enabled.



This dialog is for formatting disks.



This dialog is for labeling disks.



This dialog is for cleaning up your hard disk.



The NCD Tree is a graphical display of the drive in the active panel.



Commander Link connects two computers together via a cable using the serial or parallel port.



This dialog displays which files are associated with an application. Click on a file type, and its extension and any application 
associated with it is displayed at the bottom. Click on Add, Edit or Remove to change your file associations.



Type the extension, association (the application that you want to use to with the file) and a description of the file type. You can use 
the browse icon to find the application you want.



A header is text that appears at the top of every page of your document.



A footer is text that appears at the bottom of every page of your document.



Select the font (typeface), style and point size for your text.



Choose a border for your header or footer.



Choose your print options here.



Choose your printer, print range and number of copies here.





About Quick View Plus
Quick View Plus is an add-on systems utility that significantly enhances the Quick View function in Windows    to give users almost 
unlimited file sharing and organizing capabilities. Both are based on award-winning Outside In viewer technology from Inso 
Corporation, the leader in viewing technology. 
Quick View Plus is the “big brother” to Quick View as it enhances and expands Quick View’s functionality. In addition to the basic 
formatting features supported by Quick View, Quick View Plus adds support for such features as typeface, type size, line spacing, 
embedded graphics, and objects. While Quick View enables users to view files in about 30 of the most popular formats, Quick View 
Plus allows users not only to view files in over 200 formats, but also to copy and print them with full formatting intact. The ability to 
read and manipulate all popular word processing, spreadsheet, database, presentation and graphic files, as well as PKZIP, without 
regard to their native format, makes it much easier to communicate and work with others. 
Take the Norton Commander to new horizons.

When you use Quick View Plus with the Norton Commander, you add to its powerful tools to keep your drives and directories 
organized: preview and clean-up old documents easily; look quickly at files before recycling or deleting them; copy, backup, 
rename, move and e-mail files with confidence. 
In a Norton Commander panel, highlight any file name and choose View from the Files menu, pr press F3. Instantly, you see a 
fully formatted view of the selected file in the View window.
You can move the selection bar up or down with the Arrow keys and view one selected file after another.
Seamless integration with the Norton Commander and the NC Network Utilities make Quick View Plus instantly available for 
viewing all your files

Click here {button ,AL("qvplus2")} for more information.



More about Quick View Plus
The essential tool for networks, including the Internet

View, use, and print any file, regardless of its source: E-mail, networks, bulletin boards, online services even the Internet. 
Quick View Plus integrates with the Norton Commander and the NC Network Utilities to offer fast, efficient handling of all the files
you receive from online services, e-mail and the Internet. You’ll never get stuck with "garbage" attachments, or have e-mail 
attachments you can’t read.

Find anything fast
Quick View Plus adds power to the Find File command to save time. It’s the fastest way to view any file. You don’t have to launch
an application if you just need a quick look. If you’ve searched for a text string in a file, Quick View Plus displays the file at the 
point of the first occurrence with the particular text highlighted.

Print anything fast
Quick View Plus lets you print all or part of any file without running its application. Even if you don’t have the program that 
created the file, you get instant, fully formatted output with fonts, graphics, OLE objects and tables intact.

More things to try using Quick View Plus:
View multiple files. You can easily view multiple files with Quick View Plus without cluttering up your desktop by having 

to repeat the launch process. Use drag and drop to view one file after another in the same View Window. Simply select a file and 
drag it to an open Quick View Plus Window. 

View and use embedded objects in your word processing files. Quick View Plus supports embedded objects that 
were created through the Object Linking and Embedding(OLE) process. Double-click on the object and a Quick View Plus Window 
will appear with its contents displayed.

Copy all or parts of files, including graphics. Quick View Plus lets you copy files, including DOS and Macintosh files, 
with full formatting intact, and paste them into any Windows word processing or presentation program: grab parts of several 
documents or graphic files to build new ones without wasting time launching applications. You can use Quick View Plus to re-size 
and crop graphic files, too. 

View ZIP files in an instant. Quick View Plus supports PKZIP files. You can view, search and move individual files within 
a zip file easily without unzipping the entire file. With Quick View Plus you view the contents of an individual archived file just like 
any other file. Then individual files can be unzipped for viewing, copying, or printing.
Click here {button ,AL("qvplus;inso")} for related information.



Formats supported by Quick View Plus
Document formats
Ami / Ami Professional Versions through 3.1
DEC WPS Plus (DX) Versions through 4.1
DisplayWrite 2 & 3 (TXT) All versions
DisplayWrite 4 & 5 Versions through Release

2.0
Enable Versions 3.0, 4.0 and 4.5
First Choice Versions through 3.0
Framework Version 3.0
HTML (Internet World Wide 
Web)

Versions through 3.0

IBM FFT All versions
IBM Revisable Form Text All versions
IBM Writing Assistant Version 1.01
JustWrite Versions through 3.0
Legacy Versions through 1.1
MacWrite II Version 1.1
Manuscript Version 2.0
MASS11 Versions through 8.0
Microsoft Rich Text Format Versions through 2.0
Microsoft Windows Write Versions through 3.0
Microsoft Word for DOS Versions through 6.0
Microsoft Word for Macintosh Versions 4.0 through 6.0
Microsoft Word for Windows Versions through 7.0
Microsoft Works for DOS Versions through 2.0
Microsoft Works for Macintosh Versions through 2.0
Microsoft Works for Windows Versions through 4.0
MultiMate Versions through 4.0
Navy DIF All versions
Nota Bene Version 3.0
Office Writer Version 4.0 to 6.0
PC-File Letter Versions through 5.0
PC-File+ Letter Versions through 3.0
PFS:Write Versions A, B, and C
Plain Text (including ASCII, 
ANSI, Unicode)

n/a

Plain Text with UUEncoded 
objects

n/a

Professional Write Versions through 2.1
Professional Write Plus Version 1.0
Q&A Version 2.0
Q&A Write for Windows Version 3.0
Samna Word Versions through Samna 

Word IV+
SmartWare II Version 1.02
Sprint Versions through 1.0
Total Word Version 1.2
Volkswriter 3 & 4 Versions through 1.0
Wang PC (IWP) Versions through 2.6
WordMARC Versions through 

Composer Plus
WordPerfect Versions through 6.1
WordPerfect for Macintosh Versions 1.02 through 3.0
WordPerfect for Windows Versions through 6.1



WordStar Versions through 7.0
WordStar 2000 Versions through 3.0
WordStar for Windows Version 1.0
XyWrite Versions through III Plus
Spreadsheet formats
Enable Versions 3.0, 4.0 and 4.5
First Choice Versions through 3.0
Framework Version 3.0
Lotus 1-2-3 Charts for DOS & 
Windows

Versions through 5.0

Lotus 1-2-3 Charts for OS/2 Versions through 2.0
Lotus 1-2-3 for DOS & 
Windows

Versions through 5.0

Lotus 1-2-3 for OS/2 Versions through 2.0
Lotus Symphony Versions 1.0,1.1 and 2.0
Microsoft Excel Charts Versions 3.0 - 7.0
Microsoft Excel for Macintosh Versions 3.0 - 4.0
Microsoft Excel for Windows Versions 2.2 through 7.0
Microsoft Multiplan Version 4.0
Microsoft Works for DOS Versions through 2.0
Microsoft Works for Macintosh Versions through 2.0
Microsoft Works for Windows Versions through 4.0
Mosaic Twin Version 2.5
PFS:Professional Plan Version 1.0
QuattroPro for DOS Versions through 5.0
QuattroPro for Windows Versions through 6.0
SmartWare II Version 1.02
SuperCalc 5 Version 4.0
VP Planner 3D Version 1.0
Database formats
Access Versions through 2.0
DataEase Version 4.0
dBASE Versions through 5.0
dBXL Version 1.3
Enable Versions 3.0, 4.0 and 4.5
First Choice Versions through 3.0
FoxBase Version 2.1
Framework Version 3.0
Microsoft Works for DOS Versions through 2.0
Microsoft Works for Macintosh Versions through 2.0
Microsoft Works for Windows Versions through 4.0
Paradox for DOS Versions through 4.0
Paradox for Windows Versions through 1.0
Personal R:BASE Version 1.0
Q & A Versions through 2.0
R:BASE Versions through 3.1
R:BASE System V Version 1.0
Reflex Version 2.0
SmartWare II Version 1.02
Graphic formats
Ami Draw (SDW) n/a
AutoCAD DXF (Binary and 
ASCII)

Versions 12 and 13

Binary Group 3 Fax All versions



CompuServe GIF All versions
Computer Graphics Metafile n/a
Corel Draw (TIFF header only) Versions 2.0 through 5.0
DCX (multi-page PCX) n/a
Encapsulated PostScript (TIFF
header only)

n/a

GEM Paint (IMG) n/a
HPGL Hewlett Packard 
Graphics Language

Version 2

JPEG All versions
Lotus PIC n/a
Lotus Snapshot All versions
Macintosh PICT1 & PICT2 
(Bitmap only)

n/a

MacPaint n/a
Micrografx Designer and Draw
(DRW)

Versions through 4.0

OS/2 Bitmap All versions
PCX (Paintbrush) All versions
TIFF Versions through 6
TIFF CCITT Group 3 & 4 Versions through 6
Truevision TGA (TARGA) Version 2.0
Windows Bitmap All versions
Windows Cursor All versions
Windows Icon All versions
Windows Metafile Versions through 3.1
WordPerfect Graphics [WPG 
and WPG2]

Versions through 2.0

Presentation formats
Freelance for OS/2 Versions through 2.0
Freelance for Windows Version 2.0
Harvard Graphics for DOS Versions 2.x & 3.x
Microsoft PowerPoint for 
Macintosh

Version 4.0

Microsoft PowerPoint for 
Windows

Versions through 7.0

Compressed and Collection formats
Microsoft Binder Version 7.0
Unix Compress n/a
Unix TAR n/a
ZIP PKWARE versions through 2.04g
Other formats
DOS EXE All versions
Windows 16bit EXE or DLL All versions
Windows 32bit EXE or DLL All versions
Click here {button ,AL("qvplus")} for related information.



How to contact Inso Corporation:
Mail

401 North Wabash

Suite 600
Chicago, IL 60611    

Phone
(United Kingdom) +44.181.947.1122

Fax

(United States) +1.312.670.0820

CompuServe
72662,67

Internet

supportchi@inso.com

saleschi@inso.com

World Wide Web Site

http://www.inso.com

How to acquire Quick View Plus:

Quick View Plus is available wherever you buy software. You may download a fully-functional trial version of Quick View Plus from 
our Web Site at http://www.inso.com, or you can contact Inso Corporation directly at one of the numbers listed above.





Choose a font for your header/footer.



Check these options if you want them to be enabled.



Setting Headers and Footers in the Norton Commander Editor
You can improve the appearance of your documents with the Norton Commander Editor by adding headers, footers, and borders.

To add headers or footers to a document:

1 Open the document with the Editor by highlighting it in a Commander panel and pressing F4, or, if you have selected an external
editor in your configuration options, by pressing ALT+F4.

2 Select Header/Footer from the Options menu.

3 Type your header or footer in the appropriate textbox.

4 The default position in left-justified. If you want your header/footer to be center-justified, type a comma before the text.    If you 
want your header/footer to be right-justified, type two commas before the text.

5 If you want to set a border at the top or bottom of each page, even if you don't have any header/footer text, choose a border 
from the Borders drop-down listboxes. You options are a thin, medium or heavy line.

6 If you want to set a different font for your header/footer, click on the Change font button. You can set the font, style and point 
size.

7 When you are satisfied, click on OK to return to the NC Editor.

Tip: You can see how your header/footer looks on the page by choosing Print Preview from the File menu in the NC Editor.

Click here {button ,AL("edit")} for related information.



Setting Fonts in the Norton Commander Editor
You can improve the appearance of your documents with the Norton Commander editor by adding or changing the fonts.

To add    or change fonts in a document:

1 Open the document with the Editor by highlighting it in a Commander panel and pressing F4, or, if you have selected an external
editor in your configuration options, by pressing ALT+F4.

2 Select Font from the Options menu.

3 Specify the font, style, point size, effects and color that you wish.

4 When you are satisfied, click on OK to return to the NC Editor.

Tip: You can see how your header/footer looks on the page by choosing Print Preview from the File menu in the NC Editor.

Click here {button ,AL("edit")} for related information.



Setting Display Options in the NC Network Utilities
You can change your display options in the NC Network Utilities. You can choose to show or hide the Entire Network, the Network 
Neighborhood, the Desktop, My Computer, the Recycle Bin, the Startup Folder, Send To, Recent, the Start, Programs and 
Documents menus, the Shell, the Control Panel, installed printers and Fonts, and a user-defined Network Neighborhood.

To change display options:

1 Choose Network Utilities from the Disk menu or select NC Network Utilities from the Windows Programs menu. The NC Network
Utilities dialog box is displayed.

2 Choose Options from the View menu. The Options dialog box is displayed.

3 Check or uncheck the Options checkboxes as desired.

4 When you are finished, click on OK to return to the NC Network Utilities.

Click here {button ,AL("networks")} for related information.
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About Synchronizing Directories
There are many occasions when you need to have two directories identical — that all the files in one directory are the same as the 
files in the other — for example if you want to ensure that all the files on your portable are the same as the files on your desktop 
machine.

Click here {button ,AL("folders")} for related information.



Adding or Editing Editor Associations
An editor association tells the Commander which editor to run when you choose to edit a particular file type. To tell the Commander 
which editor to run when you press F4 or choose Edit from the Files menu on a selected file, you must create (or edit) the extension 
file. The extension file associates the extension to the appropriate program.

To create a new editor association or edit an existing editor association:

1 Choose Editors from the Commands menu. The Editors dialog appears.

2 Click on the Insert button, or, if you want to change an extension, highlight the type of file you want to make a new association 
for and then click on the Modify button.

3 The Add/Edit Editors dialog appears. In the Extension textbox, type the file extension, for example, .dtf. There is no need to type 
in the period that precedes the extension.

4 In the Command textbox, type the command for the editor, or click on the browse icon to locate it.

5 Click on OK to return to the Editors dialog. 

6 Click on OK again to save the changes to the extension file.

Click here {button ,AL("edit;associate")} for related information.



This dialog displays which files are associated with a particular editor. Click on a file type, and its extension and any application 
associated with it is displayed at the bottom. Click on Insert, Modify or Delete to change your editor associations.



Type the extension and the command for the editor. You can use the browse icon to find the editor you want.



Setting Display Options for Comparing Files
You can customize your display options in the Compare Files dialog. You can choose the font, point size, style and color of the text 
displayed in the files being compared, for both text and hex files. You can also choose the color that is used to highlight the 
differences between files.

To customize Compare Files display options:

1 Choose Compare Files from the Commands menu. The Compare Files dialog box is displayed.

2 Choose Customize from the Options menu. The Customize dialog box is displayed.

3 To change the font displayed for text files, click on the Text Font button. The font dialog is displayed.

4 Specify the font, style, point size, effects and color that you wish.

5 When you are satisfied, click on OK to return to the Customize dialog.

6 To change the font displayed for hex files, click on the Hex Font button and follow steps 4 and 5 above.

7 To change the color used to highlight differences between files, click on the Difference Color button. The color palette appears.

8 Click on color that you want to use to highlight differences.

9 When you are satisfied, click on OK to return to the Compare Files dialog.

Click here {button ,AL("compare")} for related information.



Customize the way compared files are displayed.



Choose a font for displaying compared text files.



Choose a font for displaying compared hex files.



Choose a color for highlighting the differences between files.






